
BA00064S/04/en/13.13

Version 1.01.xx

71213937

Operating Instructions

WirelessHART Fieldgate SWG70

Intelligent WirelessHART gateway 

with Ethernet and RS-485 interfaces





WirelessHART Fieldgate SWG70 Table of Contents

Endress+Hauser 1

Table of Contents

Revision History  . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

Registered Trademarks  . . . . . . . . . . . . . . . . . . . . . . 3

1 Safety . . . . . . . . . . . . . . . . . . . . . . . . . . 4

1.1 Designated use  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4

1.2 Installation, commissioning and operation  . . . . . . . .  4

1.3 Operational safety  . . . . . . . . . . . . . . . . . . . . . . . . . .  4

1.4 Conformance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5

1.5 Radio Approvals  . . . . . . . . . . . . . . . . . . . . . . . . . . .  5

1.6 Technical improvement . . . . . . . . . . . . . . . . . . . . . .  5

1.7 Conventions and icons  . . . . . . . . . . . . . . . . . . . . . .  6

2 Identification  . . . . . . . . . . . . . . . . . . . . 7

2.1 Unpacking . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7

2.1.1 Visual inspection . . . . . . . . . . . . . . . . . . . . .  7

2.1.2 Scope of delivery . . . . . . . . . . . . . . . . . . . . .  7

2.1.3 Storage und transport  . . . . . . . . . . . . . . . . .  7

2.2 Device designation  . . . . . . . . . . . . . . . . . . . . . . . . .  8

2.3 Licensing agreement  . . . . . . . . . . . . . . . . . . . . . . . .  8

3 Function and System Design  . . . . . . . . 9

3.1 WirelessHART protocol . . . . . . . . . . . . . . . . . . . . . .  9

3.2 WirelessHART network . . . . . . . . . . . . . . . . . . . . .  10

3.2.1 Network management . . . . . . . . . . . . . . . .  10

3.2.2 Security management  . . . . . . . . . . . . . . . .  10

3.3 Connection to host applications . . . . . . . . . . . . . . .  11

3.3.1 Instrument List  . . . . . . . . . . . . . . . . . . . . .  11

3.3.2 Cache . . . . . . . . . . . . . . . . . . . . . . . . . . . .  12

4 Mechanical Installation  . . . . . . . . . . . 13

4.1 Mounting considerations . . . . . . . . . . . . . . . . . . . .  13

4.1.1 Positioning the Fieldgate  . . . . . . . . . . . . . .  13

4.1.2 Positioning the antenna . . . . . . . . . . . . . . .  13

4.1.3 Antenna characteristics  . . . . . . . . . . . . . . .  14

4.1.4 Antenna range . . . . . . . . . . . . . . . . . . . . . .  15

4.1.5 Examples for good and poor positioning . . .  16

4.2 Mounting the antenna . . . . . . . . . . . . . . . . . . . . . .  17

4.2.1 Mounting the antenna supplied . . . . . . . . .  17

4.2.2 Requirements for a remote antenna . . . . . .  17

4.2.3 Connecting a remote antenna  . . . . . . . . . .  18

4.3 Mounting the Fieldgate . . . . . . . . . . . . . . . . . . . . .  19

5 Electrical Installation . . . . . . . . . . . . . 20

5.1 Connections and interfaces  . . . . . . . . . . . . . . . . . .  20

5.2 Connecting to power supply and grounding . . . . . .  21

5.3 Connecting to Ethernet . . . . . . . . . . . . . . . . . . . . .  22

5.4 Connecting to RS-485 . . . . . . . . . . . . . . . . . . . . . .  23

5.5 Cable glands and housing cover . . . . . . . . . . . . . . .  24

6 Operation  . . . . . . . . . . . . . . . . . . . . . . 25

6.1 Operating and display elements  . . . . . . . . . . . . . . .  25

6.1.1 LEDs . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  26

6.1.2 Buttons  . . . . . . . . . . . . . . . . . . . . . . . . . . .  27

6.1.3 DIP switches . . . . . . . . . . . . . . . . . . . . . . .  28

7 Commissioning . . . . . . . . . . . . . . . . . . 29

7.1 Preliminaries . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29

7.1.1 Software package . . . . . . . . . . . . . . . . . . . .  29

7.1.2 Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29

7.2 Ethernet connection  . . . . . . . . . . . . . . . . . . . . . . .  30

7.2.1 Changing the IP address . . . . . . . . . . . . . . .  30

7.2.2 Check the connection  . . . . . . . . . . . . . . . .  31

7.3 RS-485 connection  . . . . . . . . . . . . . . . . . . . . . . . .  32

7.4 Installing FieldCare  . . . . . . . . . . . . . . . . . . . . . . . .  33

7.4.1 Installing the Fieldgate DTM and HART IP 

CommDTM . . . . . . . . . . . . . . . . . . . . . . . .  33

7.4.2 Update the FieldCare DTM catalog  . . . . . .  34

7.5 Create a FieldCare Project  . . . . . . . . . . . . . . . . . . .  35

7.5.1 Add the HART IP CommDTM . . . . . . . . . .  35

7.5.2 Add the Fieldgate SWG70  . . . . . . . . . . . . .  36

7.5.3 Parameterize Fieldgate SWG70  . . . . . . . . .  37

7.5.4 Scan for wireless devices in the network  . .  38

7.5.5 Scan for devices connected to adapters . . . .  39

7.6 User interface  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40

8 Fieldgate Configuration . . . . . . . . . . . . 41

8.1 Identification . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

8.2 Wireless Communication . . . . . . . . . . . . . . . . . . . .  42

8.2.1 Basic Setup  . . . . . . . . . . . . . . . . . . . . . . . .  42

8.2.2 Advanced Setup . . . . . . . . . . . . . . . . . . . . .  44

8.2.3 Operating Modes . . . . . . . . . . . . . . . . . . . .  45

8.3 Wired Communication  . . . . . . . . . . . . . . . . . . . . .  46

8.3.1 Serial . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  46

8.3.2 Ethernet  . . . . . . . . . . . . . . . . . . . . . . . . . .  47

8.3.3 HART  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  48

8.3.4 Modbus . . . . . . . . . . . . . . . . . . . . . . . . . . .  49

8.3.5 AMS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  50

9 Diagnostics  . . . . . . . . . . . . . . . . . . . . . 51

9.1 Identification . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  51

9.2 Wireless Communication . . . . . . . . . . . . . . . . . . . .  52

9.2.1 Overview  . . . . . . . . . . . . . . . . . . . . . . . . .  52

9.2.2 Details . . . . . . . . . . . . . . . . . . . . . . . . . . . .  53

9.2.3 Burst Lists  . . . . . . . . . . . . . . . . . . . . . . . . .  54

9.2.4 Topology View (Diagnostics)  . . . . . . . . . . .  55

9.3 Wired Communication  . . . . . . . . . . . . . . . . . . . . .  57

9.3.1 Overview  . . . . . . . . . . . . . . . . . . . . . . . . .  57

9.3.2 HART  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  58



Table of Contents WirelessHART Fieldgate SWG70

2 Endress+Hauser

10 Engineering  . . . . . . . . . . . . . . . . . . . . 60

10.1 Instrument List . . . . . . . . . . . . . . . . . . . . . . . . . . .  60

10.1.1 General  . . . . . . . . . . . . . . . . . . . . . . . . . .  60

10.1.2 Creation and editing of an Instrument List   61

10.2 Modbus Mapping . . . . . . . . . . . . . . . . . . . . . . . . .  63

10.2.1 Modbus Settings . . . . . . . . . . . . . . . . . . . .  63

10.2.2 Input Status  . . . . . . . . . . . . . . . . . . . . . . .  64

10.2.3 Input Register . . . . . . . . . . . . . . . . . . . . . .  68

10.3 Topology View (Engineering)  . . . . . . . . . . . . . . . .  72

11 Additional Functions. . . . . . . . . . . . . . 75

11.1 Reset  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  75

11.2 Self Test . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  75

11.3 About . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  76

11.4 Firmware Upgrade (Web Server) . . . . . . . . . . . . . .  76

11.5 Change Password (Web Server)  . . . . . . . . . . . . . .  77

11.6 Set DTM Addresses (DTM) . . . . . . . . . . . . . . . . . .  77

11.7 Set Device Addresses (DTM)  . . . . . . . . . . . . . . . .  78

11.8 Upload Certificate (Web Server)  . . . . . . . . . . . . . .  79

11.8.1 Self-signed security certificate . . . . . . . . . .  79

11.8.2 Trusted security certificate  . . . . . . . . . . . .  79

12 Measurement . . . . . . . . . . . . . . . . . . . 80

13 Maintenance and Repair. . . . . . . . . . . 81

13.1 Maintenance  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  81

13.1.1 General  . . . . . . . . . . . . . . . . . . . . . . . . . .  81

13.1.2 Return to Endress+Hauser. . . . . . . . . . . . .  81

13.1.3 Disposal . . . . . . . . . . . . . . . . . . . . . . . . . .  81

13.1.4 Contact addresses . . . . . . . . . . . . . . . . . . .  81

14 Trouble-Shooting  . . . . . . . . . . . . . . . . 82

14.1 Network optimization . . . . . . . . . . . . . . . . . . . . . .  82

14.1.1 Verify Connections . . . . . . . . . . . . . . . . . .  82

14.1.2 Eliminate Bottlenecks . . . . . . . . . . . . . . . .  82

14.1.3 Expand the Network  . . . . . . . . . . . . . . . .  83

14.1.4 Optimize Coexistence with other Wireless Net-

works . . . . . . . . . . . . . . . . . . . . . . . . . . . .  83

14.2 Diagnosis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  84

14.2.1 Faults indicated by Fieldgate LEDS  . . . . . .  84

14.2.2 Wired Communication Faults . . . . . . . . . .  84

14.2.3 Wireless Communication Faults  . . . . . . . .  85

15 Technical Data . . . . . . . . . . . . . . . . . . 86

15.1 Input  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  86

15.2 Output . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  86

15.2.1 Ethernet (100 BASE-T/100 BASE TX)  . . .  86

15.2.2 RS-485 serial interface  . . . . . . . . . . . . . . .  86

15.3 Power Supply . . . . . . . . . . . . . . . . . . . . . . . . . . . .  87

15.4 Environment  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  87

15.5 Mechanical Construction  . . . . . . . . . . . . . . . . . . .  88

15.6 Operability . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  89

15.7 Certificates and Approvals  . . . . . . . . . . . . . . . . . .  89

A  Appendix: Modbus Interface . . . . . . . . 90

A.1 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  90

A.1.1 Modbus protocol  90

A.1.2 Modbus in Fieldgate  91

A.1.3 Data types  93

A.2 Rules for mapping . . . . . . . . . . . . . . . . . . . . . . . . .  94

A.2.1 Automatic mapping of analog devices (HART 

CMD3)  94

A.2.2 Digital input/output devices  95

A.3 Mapping formats . . . . . . . . . . . . . . . . . . . . . . . . . .  96

A.3.1 Dynamic process variables  96

A.3.2 Status mapping  96

A.3.3 HART CMD48 Read Additional Status Informa-

tion  97

A.3.4 Read Discrete Inputs  98

B Appendix: CSV File Formats  . . . . . . . . 99

B.1 Structure of CSV Files . . . . . . . . . . . . . . . . . . . . . .  99

B.2 Modbus Mapping CSV files . . . . . . . . . . . . . . . . . .  99

B.3 Instrument List CSV files . . . . . . . . . . . . . . . . . . .  100

B.4 Topology View CSV file  . . . . . . . . . . . . . . . . . . .  100

B.5 Details  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  101

C Appendix: HART OPC Connection  . . 102

C.1 HART OPC server . . . . . . . . . . . . . . . . . . . . . . . .  102

C.2 Creating an Ethernet network . . . . . . . . . . . . . . .  102

C.3 Viewing and editing device properties . . . . . . . . .  106

C.3.1 Fieldgate properties  106

C.3.2 Adapter properties  107

C.3.3 Device properties  108

C.3.4 Device data  113

C.4 OPC client  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  114

D Appendix: ANATEL Approval  . . . . . . 116

Index. . . . . . . . . . . . . . . . . . . . . . . . . . . 120



WirelessHART Fieldgate SWG70 Revision History

Endress+Hauser 3

Revision History

Registered Trademarks

HART®, WirelessHART®

Registered trademark of the HART Communication Foundation, Austen/TX, USA

Microsoft® , Windows® , Windows 2000® ,Windows XP®, Windows 2003 Server®, Windows 

Vista®, Windows 7®and the Microsoft logo are registered trademarks of the Microsoft Corporation.

Acrobat Reader® is a registered trade mark of the Adobe Systems Incorporated.

All other brand and product names are trademarks or registered trademarks of the companies and 

organisations in question

Package

version

Manual Changes Remarks

1.00.xx BA064S/04/en/06.10 – Original manual

1.01.xx BA00064S/04/en/13.13 New Functions Navigation changed, see Chapter 7.6

Channel Blacklisting possible, Chapter 8.2.2

Topology with signal strength; Chapter 9.2.4/10.3

Network tables revised, e.g. Chapter 8.2.3

Manual Restructuring Chapter 8 Fieldgate Configuration => Chapters 8-12

Chapter 10 Modbus => Appendix A

Chapter 9 HART OPC Server => Appendix B



1 Safety WirelessHART Fieldgate SWG70

4 Endress+Hauser

1 Safety

1.1 Designated use

Fieldgate SWG70 serves as a gateway device for WirelessHART networks. It enables WirelessHART 

devices to communicate with each other and manages security and connectivity. The Fieldgate 

converts wireless device data to a format that is compatible with host systems. 

1.2 Installation, commissioning and operation

Fieldgate SWG70 has been designed to operate safely in accordance with current technical safety 

and EU directives. 

If the fieldgate is installed incorrectly or used for applications for which it is not intended, or if the 

fieldgate is not configured correctly, it is possible that dangers may arise. For this reason, the system 

must be transported, stored, installed, connected, configured, operated and maintained according 

to the instructions in this and the associated manuals: personnel must be authorised and suitably 

qualified.

1.3 Operational safety

Location Fieldgate SWG70 fulfils the requirements of EU Guidelines for a number of applications. The 

associated environmental conditions described in Chapter 15, Technical Data, must be upheld.

The device must not be installed at locations where corrosive vapors may be present.

Hazardous areas Fieldgate SWG70 is available in a version that can be mounted in an explosion hazardous area. In 

order to ensure the necessary degree of protection: 

•  All seals must be undamaged and have been correctly fitted

•  All screws of the housing/housing cover must have been tightened with the appropriate torque

•  Only cable of the appropriate size must be used in the cable glands

•  All cable glands must have been tightened with the appropriate torque, see Chapter 5.5

•  All empty cable glands must have been sealed with sealing plugs

•  Once a Fieldgate SWG70 has been used in a non-Ex installation, it should never be used in an 

Ex installation, as there is a danger that the protective circuits have been inadvertently 

overloaded and no longer function correctly.

When installing components in explosion hazardous areas:

•  Ensure that all installation and maintenance personnel are suitably qualified

•  Check that all equipment has the appropriate safety certificates

•  Observe the specifications in the device certificates as well as national and local regulations.

Maintenance Fieldgate SWG70 may not be repaired, changed or manipulated. If there is a defect, the product 

must always be replaced with an original part.

Coexistence of wireless 

technologies

WirelessHART networks use the frequency spectrum between 2400 ... 2483.5 MHz according to 

IEEE 802.15.4. Various other wireless technologies also use this frequency spectrum, for example 

WLAN and Bluetooth. Depending upon the situation, it is possible that these different wireless 

technologies will affect each other.

When wireless technologies are used in an industrial environment, they must coexist without 

interfering with each other. If you find that systems are interfering with each other, take appropriate 

measures to ensure the operation of all wireless systems, e.g. by reconfiguring, enforcing a wireless 

compatibility policy, etc.
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1.4 Conformance

All declarations of conformity are to be found on the accompanying CD ROM in the folder 

Fieldgate SWG70=>Documentation=>Certificates.

CE Mark In attaching the CE Mark, Endress+Hauser confirms that Fieldgate SWG70 conforms to all relevant 

EU directives. Declarations of conformity are available for both Ex and Non-Ex versions.

EMC All modules are suitable for industrial use and conform to the EU Electromagnetic Compatibility 

Directive 2004/108/EC:

•  Interference emission

EN 61326-1: 2006, Class A apparatus

•  Interference immunity

EN 61326-1: 2006, industrial environment

1.5 Radio Approvals

Warning!

• When the device is in operation, a distance of at least 20 cm must be maintained at all times 

between the device antenna and the body of the user or any other person within the vicinity of 

the measuring point irrespective of application or use.

Caution!

• Changes or modifications to the Fieldgate not expressly approved by the Endress+Hauser will void 

the user’s authority to operate the equipment.

1.6 Technical improvement

Endress+Hauser reserves the right to make technical improvements to its software and equipment 

at any time and without prior notification. Where such improvements have no effect on the 

operation of the equipment, they are not documented. If the improvements effect operation, a new 

version of the operating instructions is normally issued. 

Compliance Statement/Conditions of Compliance

R&TTE This device complies with the requirements of the EC Telecommunications Directive 1999/5/EC

• ETSI EN 300 328: V1.7.1 (2006-10) 

• ETSI EN 301 489-17: V1.2.1 (2002-08)

• EN 60950: 2001

FCC This device complies with CFR 47, Part 15 of the FCC Rules. Operation is subject to the following 

two conditions: (1) This device may not cause harmful interference, and (2) this device must accept 

any interference received, including interference that may cause undesired operation.

Chinese This device has been granted a type approval by the SRRC (State Radio Regulatory Commission of P. 

R. China): CMIIT ID 2011DJ5310

Japanese This device has been granted a designation number by the Japanese Ministry of Internal Affairs and 

Communications according to the Ordinance concerning Technical Regulations Conformity 

Certification etc. of Specified Radio Equipment ((  )
• Article 2 clause 1 item 19 

• Approval No.: 202WW09117712

This device should not be modified (otherwise the granted designation number will be invalid)

Mexican La operación de este equipo está sujeta a las siguientes dos condiciones: (1) es posible que este equipo 

o dispositivo no cause interferencia perjudicial y (2) este equipo o dispositivo debe aceptar cualquier 

interferencia, incluyendo la que pueda causar su operación no deseada.

• COFETEL Approval No.: RCPENSW12-0651

Brazilian ANATEL 2759-11-7311 (EAN Number: 7898994191414)

“Este produto está homologado pela ANATEL, de acordo com os procedimentos regulamentados pela 

Resolução 242/2000, e atende aos requisitos técnicos aplicados.”

Para maiores informações, consulte o site da ANATEL www.anatel.gov.br

R



1 Safety WirelessHART Fieldgate SWG70

6 Endress+Hauser

1.7 Conventions and icons

In order to highlight safety relevant or alternative operating procedures in the manual, the following 

conventions have been used, each indicated by a corresponding icon in the margin. 

Safety conventions

Explosion protection .

Electrical symbols .

Icon Meaning

DANGER!

This symbol alerts you to a dangerous situation. Failure to avoid this situation will result in 

serious or fatal injury.

WARNING!

This symbol alerts you to a dangerous situation. Failure to avoid this situation can result in 

serious or fatal injury.

CAUTION!

This symbol alerts you to a dangerous situation. Failure to avoid this situation can result in minor 

or medium injury.

NOTE!

This symbol contains information on procedures and other facts which do not result in personal 

injury.

Icon Meaning

Device certified for use in explosion hazardous area

If the device has this symbol embossed on its name plate it can be installed in an explosion hazardous area 

in accordance with the specifications in the certificate or in a safe area

Explosion hazardous area

Symbol used in drawings to indicate explosion hazardous areas. Devices located in and wiring entering 

areas with the designation “explosion hazardous areas” must conform with the stated type of protection

Safe area (non-explosion hazardous area)

Symbol used in drawings to indicate, if necessary, non-explosion hazardous areas. Devices located in safe 

areas stiill require a certificate if their outputs run into explosion hazardous areas

Icon Meaning

Direct voltage

A terminal to which or from which a direct current or voltage may be applied or supplied

Alternating voltage

A terminal to which or from which an alternating (sine-wave) current or voltage may be applied or supplied

Grounded terminal

A grounded terminal, which as far as the operator is concerned, is already grounded by means of an earth 

grounding system

Protective grounding (earth) terminal

A terminal which must be connected to earth ground prior to making any other connection to the 

equipment

Equipotential connection (earth bonding)

A connection made to the plant grounding system which may be of type e.g. neutral star or equipotential 

line according to national or company practice 
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2 Identification

2.1 Unpacking

2.1.1 Visual inspection

During unpacking:

•  Check the packing materials for signs of transportation damage

•  Remove the packaging material with care, so as not to damage the Fieldgate

•  Store the original packing material, in case the Fieldgate must be shipped again

•  Keep the documentation supplied with the Fieldgate in a safe place

In the event of damage to the Fieldgate, contact your Endress+Hauser Sales Center, see 

Chapter 13.1.2. Where possible, return the fieldgate to us in its original packing.

2.1.2 Scope of delivery

Please check that the delivery is complete and free of defects before starting installation. The scope 

of delivery comprises the following parts:

•  WirelessHART Fieldgate SWG70

•  Antenna

•  Short instructions and CD-ROM

•  Depending upon order, FieldCare Device Setup DVD

2.1.3 Storage und transport

Always store and transport the device in the original packaging.

Always store the device in a clean, dry environment. Note the permitted storage temperature,

see Chapter 15.4.
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2.2 Device designation

The device designation together with other information is to be found on the nameplate affixed to 

the front of the Fieldgate, see Fig. 2-1.

Fig. 2-1:  Nameplate

The device type can be derived from the order code as follows:

2.3 Licensing agreement 

The Product CD-ROM and FieldCare Device Setup DVD supplied with the WirelessHART fieldgate 

contain a number of components that are required for its commissioning. These can be installed 

free-of-charge on the computer to be used with the Fieldgate. 

Information on the various Windows versions supported is to be found in the folder System 

Requirements on the Product CD-ROM.

The full licensing agreement is also to be found on the CD-ROM. The software required for start-

up and commissioning, i.e. the Internet browser, is either freely available or is subject to the 

licensing conditions of its manufacturer. Installation of this software on your computer implies that 

you accept the terms of the corresponding licensing agreement.

1 Order code 3 Type of protection, if any

2 Serial number 4 Telecommunication compliance

CMIIT ID 2011DJ5310

1 2 3

4

WirelessHART Fieldgate SWG70

Approvals

AA

BG

Non-hazardous area

ATEX II 3G Ex nA II T4

Output

1

9

Ethernet + RS-485 + HART; OPC + Modbus

Special version

Service

IK

IW

Customized configuration 

Without tooling DVD (FieldCare Setup)

Marking

Z1 Tagging (TAG)

52006327: Self-adhesive paper label

52006328: Supplied label/plate

SWG70- Product designation
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3 Function and System Design

3.1 WirelessHART protocol

The HART protocol has until now used the wired 4–20mA loop with a superimposed digital signal 

as physical layer. Although full digital communication is available in multidrop mode, the majority 

of transmitters are connected to analog I/O cards and digital communication is used only for 

parameterization, diagnosis and maintenance purposes. 

WirelessHART now allows for the wireless transmission of HART data. To be employable 

worldwide, WirelessHART utilizes the 2.4 GHz Band (IEEE 802.15.4 wireless network) as physical 

layer. The WirelessHART devices form a mesh network in which every device is not just a 

measurement point, but also a repeater. This results in a wider range for the whole network as well 

as increased reliability through redundant communication paths.

The network may comprise three types of device:

•  WirelessHART gateway (Fieldgate SWG70)

•  WirelessHART field devices

•  WirelessHART adapters (either connected to 4–20 mA/HART devices or acting as repeaters)

The WirelessHART network is built up, organized and maintained by the Fieldgate, which also takes 

care for connection to different HOST systems through different bus interfaces.

Fig. 3-1: WirelessHART network

Host applications

Ethernet

WirelessHART 
Fieldgate SWA70

Field devices with 
Wireless Adapter SWA70
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3.2 WirelessHART network

Fieldgate SWG70 is the master device in the WirelessHART network. Acting as network manager, 

it recognizes other devices wanting to join the network. It makes contact with each in turn and 

initiates the procedures required for them to join. The network organizes itself without any 

intervention on the part of the user. Fieldgate SWG70 also acts as security manager and collects the 

data sent by the network participants, converting it into a form which can be used by other systems 

connected to it. 

3.2.1 Network management

In its role as network manager, Fieldgate SWG70 organizes the wireless communication between 

the WirelessHART field devices. 

Fig. 3-2: Network management

After the Fieldgate has started up the network, devices can join. To this end, it first sends out a call 

for devices to join the network. Then, the device sends a join request to announce its wish to join 

the network. If the WirelessHART field device can identify itself with the same network ID and join 

key as stored in the WirelessHART gateway, the field device is authorized to join the network. 

Otherwise, the field device will be rejected.

In the next step, the WirelessHART gateway sends session and network keys as well as scheduling 

and routing information to the field device. The field device is told how to participate in the network 

and receives various information from the WirelessHART gateway:

•  Number and identity of neighbouring WirelessHART field devices,

•  When to send messages and which channels to use,

•  When to repeat messages for other WirelessHART field devices,

•  The optimal communication path for messages as well as alternative communication paths in 

case of failure.

During this process, the WirelessHART device or adapter may also apply to send messages in certain 

intervals and ask the network manager for the appropriate resources. The network manager then 

takes care that these resources are available. For example, the network manager informs other 

WirelessHART field devices when to repeat messages.

3.2.2 Security management

Fieldgate SWG70 also acts as security manager. To make communication safe, all messages are 

encrypted with industry-standard AES-128 block ciphers with symmetric keys. Therefore, messages 

are unreadable for external listeners. The encryption keys are distributed by the security manager.

The Join Key is used to join the network. Subsequently, the Join Key is automatically exchanged 

against the Session Key and the Network Key, i.e. two new additional keys.

1 Step 1: Advertising 4 WirelessHART gateway (Fieldgate SWG70)

2 Step 2: Join Request 5 WirelessHART device or adapter

3 Step 3: Authorization, Session & Network 

Keys, Scheduling and Routing

1

2

3
4 5
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3.3 Connection to host applications

Fieldgate SWG70 also makes wireless communication accessible to HART-capable host systems via 

its Ethernet or serial interfaces through the following functions.

3.3.1 Instrument List

WirelessHART devices in the network are made available to host systems via an instrument list. This 

list contains one or more I/O cards. Every I/O card has one or more channels. Up to 15 field devices 

(for WirelessHART Adapter SWA70 max. four) can be connected in multidrop mode to each 

channel, see Fig. 3-3. The list itself can be up and downloaded, see Chapter 10.1.

Fieldgate SWG70 assigns a virtual I/O card to each WirelessHART device. The I/O cards are 

assigned to the WirelessHART devices in the order in which they join the network. New 

WirelessHART devices in the network are assigned to the next available I/O card, which is added 

to the end of the instrument list (First-in-First-Out principle). 

Within an I/O card, the WirelessHART device itself as well as status information is assigned to 

Channel 0. If the WirelessHART device is an adapter, all field devices connected to it are assigned 

to channel 1 (multi-drop mode). The list of the connected field devices is also called sub-device list.

Fig. 3-3: Instrument list

If a WirelessHART device loses communication to the gateway, it stays assigned to the I/O card 

initially allocated to it. When communication is established again, the device thus has the same 

position in the instrument list that it had before. 

The same principle applies to the field devices connected to the WirelessHART adapter. When 

communication to the gateway is lost, the long tags of the filed devices are stored. After 

communication has been established again, the field devices regain their previous position in the 

instrument list.

1

2

3

4

5

WirelessHART Gateway

I/O Card 1

I/O Card 2

Channel 0

WirelessHART Field Device

WirelessHART Adapter

Channel 0

Channel 1

HART Field Device 1

HART Field Device 2

HART Field Device 3

Network Structure I/O Structure Instrument List

1

2

3

4

5

5

5
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3.3.2 Cache

The WirelessHART gateway stores information received over the WirelessHART network and 

makes it available to the host for further processing. This ensures that information is available 

immediately for the host system without having to send a request to the device and wait for the 

response. The following commands and answers to requests are cached in the gateway.

Information cached in the 

WirelessHART gateway

Each listed command has its own cache memory. Static commands are stored in the cache upon the 

first request. These contain device parameters, e.g. tags, that do not normally change. Dynamic 

variables are stored each time a field device sends a burst message so that up-to-date values are 

available at all times.

With the exception of commands the Write commands 17, 18, 22 and 51, when the WirelessHART 

gateway receives a request from a host system which is embedded in Command 77, the response is 

sent immediately (provided that the response is available in the cache).

Long Tag Emulation WirelessHART uses the long tag for addressing devices. Not every HART device supports long tags, 

for example, older HART devices with HART Protocol Version 5 or less, do not support long tag 

addressing. 

If a HART 5.0 device is connected to a WirelessHART adapter, the WirelessHART gateway emulates 

the long tag using the "Message" field. When a host system addresses a HART 5 device, the 

emulation translates Command 20(22) directly into Command 12 (17) which the HART 5 

understands. The response is stored in the gateway cache for CMD 12(17) and for CMD 20(22).

Cache HART Command Description

Static: cached upon read 0, 11, 21 Read unique identifier (associated with tag or long tag)

Static: cached upon read 

& write confirmation

12, (17) Read (Write) Message

13, (18) Read (Write) Short Tag, Descriptor, Date

20, (22) Read (Write) Long Tag

50 (51) Read (Write) Dynamic Variable Assignments

Dynamic: cached on 

publication only

1 Read Primary Variable

2 Read Current and Percentage

3 Read All Variables

9 Read Device Variables and Status

33 Read Device Variables

48 Read Additional Device Status

38 Reset Configuration Change Counter

93 Read Trend
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4 Mechanical Installation

NOTE! 

• It is recommended that Fieldgate SWG70, adapters and devices be setup on the test bench and 

the network be tested before the components are installed in the field.

4.1 Mounting considerations

4.1.1 Positioning the Fieldgate

Install the gateway first, before installing other WirelessHART devices. This way you can check for 

proper operation of new devices as they are installed. Nevertheless, consider the location of future 

WirelessHART devices that will be routed through the gateway to ensure good connectivity.

Guidelines for Planning a WirelessHART Network

•  Mark the positions of the various measuring points on a scale overview of the plant. It is 

important that the overview shows likely obstacles to the propagation of the radio waves 

•  Make sure that a minimum of 2 other WirelessHART devices are well within the antenna range 

of the device. If necessary, consider using an adapter as an additional stand-alone repeater. For 

more information on the antenna characteristics please refer to Chapter 4.1.3.

•  Where a lot of metal, grids or walls prevent a device from being in line-of-sight of its nearest 

neighbour, the maximum distance between two devices is 30 m. Install wireless devices at 

least 1m above the ground or the floor.

•  Where there are fewer structural elements and one or more neighbours are in direct line-of- 

sight, the maximum distance between two devices for planning purposes is 200 m. In this case, 

install wireless devices at least 3m above the ground or the floor.

•  Consider moving objects that could affect the device's antenna range.

•  Make sure that the device's antenna is aligned vertically.

•  If possible, position the Fieldgate at or near the centre of the network - it should be in contact 

with at least 20% of the devices in the network.

•  Do not position WirelessHART devices directly below or above each other as they will be 

outside each other's antenna range, see Chapter 4.1.5.

•  If possible, do not position the device next to metal surfaces, pipes or walls containing metal 

(minimum distance: 6 centimetres). There should be as little metal around the device as 

possible.

•  Do not position other 2.4 GHz devices like cordless phone bases or WLAN routers near 

WirelessHART devices. Wireless technologies used in an industrial environment must be able 

to coexist without disrupting each other. If multiple networks operate in one facility, wireless 

frequency management may be required.

4.1.2 Positioning the antenna

Fieldgate FWG70 is supplied with an omnidirectional dipole antenna that must be screwed on 

during installation, see Chapter 4.2.1. The antenna characteristics and details of positioning are to 

be found in Chapters 4.1.3 to 4.1.5. 

If the application requires that the Fieldgate be mounted in a protective enclosure, a remote antenna 

must connected to the antenna terminal and mounted outdoors, see Chapter 4.2.2. This antenna 

must conform with the requirements described in 4.2.2 and be mounted according to the the 

instructions in Chapter 4.2.3. The guidelines for positioning a WirelessHART device also apply to 

the positioning of a remote antenna, see Chapter 4.1.5.



4 Mechanical Installation WirelessHART Fieldgate SWG70

14 Endress+Hauser

4.1.3 Antenna characteristics

Fig. 4.1 shows the antenna gain in the vertical and horizontal planes. 

Fig. 4-1: Antenna gain in the vertical (above) and horizontal planes
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4.1.4 Antenna range

Fig. 4.2 is a schematic representation of Fig. 4.1 and shows the wave propagation with the signal 

attenuation. The antenna is an omni-directional dipole antenna. If you point the antenna upwards, 

the signal radiates horizontally at an angle of approx. 39 degrees above and below the horizontal 

(donut shaped). The most power is in the horizontal plane, decreasing to 50% at an angle of 39°. 

Almost no signal will be radiated directly above and below the antenna. Consider this when 

planning a WirelessHART network. 

The height differences between wireless devices in a network should not be too large. 

The schematic is valid only for an antenna placed outdoors with no metal surfaces near. The 

radiation pattern changes significantly when metal surfaces are close to the antenna.

Fig. 4-2: Wave propagation, schematic representation (alpha = approx. 39°)

1: No signal above and below 2: Stronger signal sideways

1

2 2

1

100% 100%

50%50%

50%50%

0%

0%



4 Mechanical Installation WirelessHART Fieldgate SWG70

16 Endress+Hauser

4.1.5 Examples for good and poor positioning

The positioning is good when the network participants are within the antenna range:

Fig. 4-3: Example of good positioning

The positioning is poor when neighbours are not in the antenna range or within the weaker signal 

zone of the antenna:

Fig. 4-4: Example of poor positioning

PWR
COM
FLT

height

distance

PWR
COM
FLT

height

distance
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4.2 Mounting the antenna

WARNING!

• When Fieldgate SWG70 is installed in Ex-Zone 2, the connection/disconnection of cables is 

permitted only in the absence of any potentially explosive atmosphere or when the Fieldgate is 

not connected to the power supply.

NOTE! 

• Use only the antenna supplied or a remote antenna that conforms to the requirements in 

Chapter 4.2.2. 

• A failure to do this will void the radio approval and/or the Ex-certificate and the Fieldgate may 

no longer be operated.

4.2.1 Mounting the antenna supplied

1 Before mounting the antenna supplied, make sure that the Fieldgate has been disconnected 

from line power.

2 Firmly screw the antenna to the device's antenna terminal 

(see Item 6 in Fig. 5.1 in Chapter 5.1).

4.2.2 Requirements for a remote antenna

WARNING!

• If Fieldgate SWG70 is to be operated in with a remote antenna installed in an explosion hazardous 

area, then the antenna must possess the appropriate Ex-certification.

NOTE! 

• The use of a remote antenna of a different type or that operates at a higher gain than specified in 

the requirements below is subject to legal restrictions.

Only remote antennas that conform with the following requirements may be connected to the 

Fieldgate.

•  The antenna must comply with the laws for usage of 2.4 GHz equipment valid in the country 

of installation

•  Radio frequency energy ≤ 50 μJ
•  Radio frequency power ≤ 2 W

•  Antenna gain ≤ 20 dBi

•  Maximum gain (EU) ≤ 4 dBi; Maximum gain (US & Canada) ≤ 2 dBi

The maximum gain must be less than or equal to the sum of the antenna gain and the losses of the 

individual components. Note that the permitted maximum gain is dependent on the country of 

installation.

Fig. 4-5: Calculating the maximum gain of a remote antenna

1 Antenna 4 Surge protector,/4, without mechanical fixing

2 Coaxial adaptor 5 Fieldgate SWG70

3 RF coaxial cable with connectors

Gain (< Maximum Gain)

Antenna gain - Cable loss - Arrester loss - Cable loss 

1

5

32

2

34
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4.2.3 Connecting a remote antenna

WARNING!

• Outdoor installations can be subject to lightning strikes. Install a surge arrestor, to protect the 

installation against transients or damage caused by lightning strikes.

NOTE! 

• Tension relief and bending radii: Ensure sufficient relief of tension on the cables during 

installation and note the minimum bending radii of the cables.

The antenna must be connected to the Fieldgate SWG70 by means of coaxial cable. A surge arrestor 

provides protection against lightening strikes. The surge arrestor must be installed directly on the 

Fieldgate SWA70 antenna connection. Install the components according to Fig. 4-6.

Fig. 4-6: Installation of an remote antenna

1 Before installing the remote antenna, make sure that the Fieldgate has been disconnected from 

line power

2 Install the components according to Fig. 4-6

3 Install the surge arrestor in a way that all indoor connections are protected

4 Connect the surge arrestor to protective grounding

5 Install the remote antenna where it is within the antenna range of other WirelessHART 

devices, see Chapter 4.1.5

1 Omnidirectional antenna 5 Surge arrestor,/4, without mechanical fixing

2 Directional antenna 6 RF coaxial cable with connectors

3 Coaxial adaptor 7 Coaxial adaptor

4 RF coaxial cable with connectors 8 Fieldgate SWG70

2

1

7

8

64 53
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4.3 Mounting the Fieldgate

In addition to fulfilling the conditions for good wireless communication, the mounting location 

should be well accessible for mounting and electrical installation. Make sure that there is enough 

space to open the housing cover and to access the terminals, switches, and cable glands. Choose a 

mounting location that meets the climatic limits specified and radio requirements in the technical 

data.

The housing has a degree of protection of IP65 and is designed for wall mounting (mounting 

accessories not included). 

Required tools:

•  2 screws (M6)

•  Drill

•  Screwdriver

Fig. 4-7: Mounting holes and housing screws 

Mounting the Gateway 1 Drill 2 holes in the mounting surface so that they match the holes of the housing

(centres 240 mm to 250 mm apart). See Chapter 15.5 for dimensioned drawing.

2 Screw the device to the mounting surface.

1 Mounting holes 2 Housing screws

2

1 1

2
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5 Electrical Installation

5.1 Connections and interfaces

The connections and interfaces are only accessible with an open enclosure. In the case of the DIP 

switches, the user has the choice of using the switch settings, or overriding the settings by software, 

see Chapter 8.

Warning!

• When Fieldgate SWG70 is installed in Ex-Ex-Zone 2, the connection/disconnection of cables is 

permitted only in the absence of any potentially explosive atmosphere or when the fieldgate is not 

connected to the power supply.

Fig. 5-1: Connections and interfaces

1 Grounding terminal 5 Antenna

2 RS-485 interfaces, duplicated terminal 

block for daisy-chain capability

6 Antenna terminal

3 Ethernet interface 7 Cable glands

4 Power supply connections (redundant)

5

1

6

1

2 3 4

7
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5.2 Connecting to power supply and grounding

There are two 24 VDC power supply terminal blocks located inside Fieldgate SWG70, allowing for 

redundant power supply. Open the housing cover to access the terminal blocks.

NOTE! 

• Tension relief and bending radii: Ensure sufficient relief of tension on the cables during 

installation and note the minimum bending radii of the cables.

Fig. 5-2: Power supply

Connecting to 24 VDC 

power supply and 

grounding

Fieldgate SWG70 must be connected to a 24 VDC (20 VDC – 30 VDC) power supply

1 Connect the grounding terminal to a ground wire.

2 Unscrew the 4 screws of the housing cover (see Fig. 4-5 in Chapter 4.2) and remove the 

housing cover.

3 Route the 24 VDC power cable through the second cable gland from right

– The permissible cable diameter lies between 6 mm and 10 mm.

4 Connect the 24 VDC power cable to the first power supply connection "Line 1" observing 

polarity (see Fig. 5-1 above).

5 If you want to connect a redundant power supply (optional), route the second 24 VDC power 

cable through the cable gland on the far right of the housing.

6 Connect the second power cable to the second power supply connection "Line 2" 

observing polarity .

7 Switch on the power: the green power LED should light immediately.

8 Tighten the cable gland with appropriate torque, see Chapter 5.5.

9 Switch off the power before making any more connections.

1 First power supply connection 3 Grounding terminals

2 Second (redundant) power supply 

connection

1 2

KL14 KL15 KL16 KL17

+24V +24V0V 0V
LINE1 LINE2

+24V +24V0V 0V
LINE1 LINE2

A B SHD
RS485

T1 T2 RX– RX+ TX– TX+

ON

OFF

SHDA B SHD
RS485 ETHERNET

3 3
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5.3 Connecting to Ethernet

Fieldgate SWG70 is equipped with a fully galvanic isolated 10 Base-T/100 Base-TX Ethernet 

interface. You may connect it to an existing Ethernet Hub, Switch or Router.

NOTE! 

• Keep in mind that an access point of the Ethernet network has to be available. The maximum 

length of the cable running from the gateway to the access point is 100 m, depending on cable 

type and communication speed.

• Tension relief and bending radii: Ensure sufficient relief of tension on the cables during 

installation and note the minimum bending radii of the cables.

Fig. 5-3: Ethernet interface

The wiring of the Ethernet interface depends on the cable used, see table below. 

•  A crossover cable is required if the gateway is connected directly to a computer

•  A straight through cable is used in connection with a hub, switch or router

The other end of the cable is fitted with a standard RJ-45 connector.

Connecting to Ethernet 

Network

1 Check that the power is switched off

2 If applicable, unscrew the four screws of the housing cover (see Fig. 4-5 in Chapter 4.2) and 

remove the housing cover.

3 Route the Ethernet cable through the cable gland in the middle of the gateway housing.

– The permissible cable diameter lies between 6 mm and 10 mm.

4 Connect the Ethernet cable to the terminal block labelled "Ethernet" (see above) according to 

the following table:

5 Screw the housing cover to the housing again.

6 Tighten the cable gland with appropriate torque, see Chapter 5.5.

KL7 KL8 KL9 KL10

+24V +24V0V 0V
LINE1 LINE2

A B SHD
RS485

T1 T2 RX– RX+ TX– TX+

ON

OFF

SHDA B SHD
RS485 ETHERNET

T1 T2 RX– RX+ TX– TX+SHD
ETHERNET

KL11 KL12 KL13

Computer Gateway

Pin Numbering Connector Crossover cable Straight through

Pin 1 TX+ RX+

Pin 2 TX– RX–

Pin 3 RX+ TX+

Pin 4 T2 T2

Pin 5 T2 T2

Pin 6 RX– TX–

Pin 7 T1 T1

Pin 8 T1 T1

1 2 3 4 5 6 7 8
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5.4 Connecting to RS-485

Fieldgate SWG70 is equipped with a fully galvanic isolated RS-485 interface. A second RS-485 

terminal block allows several gateways to be connected through a daisy chain. 

A terminating resistor is required at each end of the RS-485 cable. If the RS-485 is not routed to 

other devices (no daisy-chain connection), activate the terminating resistor integrated in the 

fieldgate.

NOTE! 

• Keep in mind the location of the Modbus PLC or DCS. The maximum length of the cable running 

from the gateway to the PLC/DCS is 1200m (at reduced communication speed).

• Use shielded twisted pair (STP) cables only.

• If the cable shield is grounded, the grounding should only be connected to one end of the cable, 

in order to avoid equipotential bonding currents.

• Tension relief and bending radii: Ensure sufficient relief of tension on the cables during 

installation and note the minimum bending radii of the cables.

Fig. 5-4: RS-485 interface

Connecting to RS-485 1 Check that the power is switched off

2 If applicable, unscrew the four screws of the housing cover (see Fig. 4-5 in Chapter 4.2) and 

remove the housing cover.

3 Route the RS-485 cable through the first cable gland from left 

– The permissible cable diameter lies between 6 mm and 10 mm.

4 Connect the RS-485 cable to the left terminal block labelled "RS485" (see Figure 5-4) as 

follows:

5 For a daisy-chain connection, route the second RS-485 cable through the second cable gland 

from left and connect it to the right terminal block labelled "RS485", see table above.

6 To activate the RS-485 termination, set DIP switch number 7 to "ON" (see Chapter 6.1.3).

7 Screw the housing cover to the housing again.

8 Tighten the cable gland with appropriate torque, see Chapter 5.5.

1 First RS-485 connection 2 Second RS-485 connection for daisy chaining

KL1 KL2 KL3 KL4

+24V +24V0V 0V
LINE1 LINE2

A B SHD
RS485

T1 T2 RX– RX+ TX– TX+

ON

OFF

SHDA B SHD
RS485 ETHERNET

KL5 KL6

A B SHD
RS485

A B SHD
RS485

1 2

Wire RS-485 cable Fieldgate terminal Remarks

RxD/TxD– (RS-485 A) A RS-485 differential 

signalRxD/TxD+ (RS-485 B) B

Shield SHD Cable shielding



5 Electrical Installation WirelessHART Fieldgate SWG70

24 Endress+Hauser

5.5 Cable glands and housing cover

The degree of protection IP 65 (NEMA Type 4) cannot be achieved if the cables and cable glands 

are not fitted correctly.

To ensure the IP degree of protection

•  all screws of the housing / housing cover must have been tightened with the appropriate 

torque,

•  only cables of the appropriate size must be used in the cable glands,

•  all cable glands must be tightened with the appropriate torque,

•  all seals must be undamaged and fitted correctly,

•  all empty cable glands must be sealed with appropriate plugs.

The tightening torques of cable glands depend on what type of cable is used and must therefore be 

determined by the user. The cap nuts must be securely tightened. Tightening the cap nuts too tight 

can have a negative effect on the protection class. The following figures can be taken as rough 

guides.

The housing cover must be installed with a torque of 24.1 Nm.

Type of cable gland Approx. installation torque

Plastic 2.5 Nm

Nickel-plated brass 4.1 Nm

Stainless steel 4.1 Nm
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6 Operation

6.1 Operating and display elements

Inside the fieldgate housing there are LED indicators, DIP switches and reset buttons. The controls 

and indicators are accessible with open enclosure.

Warning!

• When Fieldgate SWG70 is installed in Ex-Zone 2 and the power is switched on, the operation of 

DIP switches and buttons as well as the connection/disconnection of cables is permitted only in 

the absence of any potentially explosive atmosphere

• The operation of DIP switches and the connection/disconnection of cables in Ex-Zone 2 is 

permitted, however, when the power to Fieldgate SWG70 is switched off

Fig. 6-1: Operating and display elements

1 LEDs 3 Button P2

2 Button P1 4 DIP switches

1

2 3

4
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6.1.1 LEDs

Five leds indicate the status of Fieldgate SWG70:

Fig. 6-2: LED indicators

The significance of the LEDs is as follows:

Yellow LED: RS-485 

communication status

Green LED: Power supply 

and operation status

Yellow LED: 

WirelessHART 

communication status

Red LED: Device status

Yellow LED: Ethernet 

communication status

1 Yellow LED: RS-485 communication status 4 Red LED: Fault

2 Green LED: Power supply 5 Yellow LED: Ethernet communication status

3 Yellow LED: WirelessHART 

communication status

+24V +24V0V 0V
LINE1 LINE2

A B SHD
RS485

T1 T2 RX– RX+ TX– TX+

ON

OFF

SHDA B SHD
RS485 ETHERNET

1 2 3 4 5

Mode Status Significance

Flashes – Flashes shortly whenever a valid HART or Modbus message is received 

by the Gateway on the RS-485 communication line

– The LED does not flash if the message is not addressed to the gateway 

or if a communication error was detected within the message

Off – Currently no communication on the RS-485 line

Mode Status Significance

On OK Fieldgate SWG70 is powered up and running

Flashes Not ready On power-up, indicates that the Fieldgate application is running but the 

Fieldgate is not yet ready to answer HART commands

Off No power The power supply is not connected/Fieldgate is not ready

Mode Status Significance

Flashes – Flashes shortly whenever a valid WirelessHART message is received by 

the Gateway on the WirelessHART communication interface 

– Messages include simple commands but not published bursts and 

event notifications

Off – Currently no communication on the WirelessHART interface

Mode Status Significance

On Hardware fault Fieldgate has detected a hardware fault that makes normal operation 

impossible. 

Flashes Recoving from hardware 

fault

The Fieldgate application is trying to recover from the fault

(not possible for all faults)

Off No hardware fault –

Mode Status Significance

Flashes – Flashes shortly whenever a valid HART or Modbus message is received 

by the Gateway on the Ethernet communication line

– The LED does not flash if the message is not addressed to the gateway 

or if a communication error was detected within the message

Off – Currently no HART/Modbus communication on the Ethernet line
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6.1.2 Buttons

Fieldgate has two pushbuttons.

Warning!

• When Fieldgate SWG70 is installed in Ex-Zone 2 and the power is switched on, the operation of 

the pushbuttons is permitted only in the absence of any potentially explosive atmosphere.

Fig. 6-3: Pushbuttons

The function of the buttons is as follows:

Buttons

1 Button A 2 Button B

+24V +24V0V 0V
LINE1 LINE2

A B SHD
RS485

T1 T2 RX– RX+ TX– TX+

ON

OFF

SHDA B SHD
RS485 ETHERNET

1 2

1 2 3 4 5 6 7 8

Button Function Procedure

Button P1 Configuration reset Press the button for more than 3 seconds

– All Fieldgate SWG70 configuration parameters are reset to factory 

settings with exception of the parameters set by button P2 and 

button P1 + P2.

– After approx. 3 seconds, all LEDs light up to confirm the reset

Button P2 Communication reset Press the button for more than 3 seconds

– All Fieldgate SWG7 configuration parameters related to the wired 

communication channels are reset to factory settings

– After approx. 3 seconds, all LEDs light up to confirm the reset

Button P1 + P2

DIP Switch 8 OFF

Password reset Press buttons P1 and P2 simultaneously for more than 3 seconds

– All Fieldgate SWG70 passwords are reset to the factory settings

– Passwords are used for access to the Command Line Interface and 

the Web Server (HTTPS)

– For Web Server User name: admin; Password: admin

– After approx. 3 seconds, all LEDs light up to confirm the reset

Button P1 + P2

DIP Switch 8 ON

Network manager reset Press buttons P1 and P2 simultaneously for more than 3 seconds

– The Fieldgate SWG70 join key, network ID, radio power and access 

mode are reset to factory settings.

– After approx. 3 seconds, all LEDs light up to confirm the reset
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6.1.3 DIP switches

Warning!

• When Fieldgate SWG70 is installed in Ex-Zone 2 and connected to the power supply, the 

operation of DIP switches is permitted only in the absence of any potentially explosive 

atmosphere.

NOTE! 

• The same functions can be initiated from the Fieldgate SWG70 Web inteface and DTM,

see Chapter 8.4, Wired Communication

Fieldgate SWG70 has one 8-gang DIP switch. Fieldgate SWG70 is delivered with all DIP switches 

set to ON and with all DIP switch functions set by software controls.

Fig. 6-4: DIP switches

DIP switch positions

Security mode When DIP Switch 8 is OFF, it is not possible to download the Network ID and the Join Key to the 

gateway, see Chapter 8.3.1. Fieldgate SWG70 is delivered with the the download enabled by 

default, i.e. DIP Switch 8 is ON.

1 Switches 1 – 4: Polling address 3 Switch 7: RS-485 termination

2 Switches 5 – 6: Baudrate 4 Switch 8: Security mode

+24V +24V0V 0V
LINE1 LINE2

A B SHD
RS485

T1 T2 RX– RX+ TX– TX+

ON

OFF

SHDA B SHD
RS485 ETHERNET

1 2 3 4

ON

OFF
1 2 3 4 5 6 7 8

Switch Function SW1 SW2 SW3 SW4 Value SW1 SW2 SW3 SW4 Value

SW1 - SW4 Bus address 1) OFF OFF OFF OFF 0 OFF OFF OFF ON 8

ON OFF OFF OFF 1 ON OFF OFF ON 9

OFF ON OFF OFF 2 OFF ON OFF ON 10

ON ON OFF OFF 3 ON ON OFF ON 11

OFF OFF ON OFF 4 OFF OFF ON ON 12

ON OFF ON OFF 5 ON OFF ON ON 13

OFF ON ON OFF 6 OFF ON ON ON 14

ON ON ON OFF 7 ON ON ON ON 15

SW5 SW6 Value SW5 SW6 Value

SW5- SW6 Baudrate 2) OFF OFF 9600 OFF ON 38400

ON OFF 19200 ON ON 57600

SW7 RS-485 termination • OFF = disconnected • ON = connected

SW8 Download 

Join Key/Network ID

• OFF = disabled • ON = enabled

1) Addresses from 0 to 63 can be set by software

2) If the DIP switches are used, the baudrate applies to both HART and MODBUS protocols. 

Software configuration allows additional baudrates to be set for HART and MODBUS protocols (Chapter 8.4.3/8.4.4)
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7 Commissioning

NOTE! 

• It is recommended that Fieldgate SWG70, adapters and devices be setup on the test bench and 

the network be tested before the components are installed in the field.

7.1 Preliminaries

7.1.1 Software package

The CD ROM delivered with Fieldgate SWG70 contains the following components which must be 

installed on your computer prior to configuration as described in Chapter 7.4. 

•  FieldCare Device Setup

•  Any DTMs supplied to be found on the CD, e.g. Fieldgate DTM and HART IP CommDTM

NOTE! 

• You need to be logged on to Windows with administrator privileges during installation

• If one of the software components is already installed on your system its installation may be 

omitted

7.1.2 Setup

There are two possibilities to set up Fieldgate SWG70

•  via Web Server

•  via FieldCare

Web Server Fieldgate SWG70 has a integral Web Server which can be used to set up and monitor both the 

device and the network. The structure of the parameter blocks and parameters is identical with that 

of the Fieldgate SWG70 DTM. Connection to the Web Server is made by an Internet browser, e.g. 

Windows Explorer. 

To connect to and set up via Web Server, follow the preliminary procedures in Chapter 7.2.

FieldCare Setup via FieldCare differs from the Web Server in that it is also possible to parameterize the 

WirelessHART Adapter SWA70 as well as any connected HART devices. A prerequisite is that the 

field devices already have the same join key and network identifier as Fieldgate SWG70 and have 

joined the network. Attached devices can be configured via their DTMs.

NOTE! 

• We recommend that the adapters and connected HART devices are parameterized by a direct 

connection as described in Operating Instructions BA00061S/04/en. If FieldCare accesses the 

devices via the Fieldgate SWG70 DTM, the response times may be considerably longer than for 

a direct connection.

To setup via FieldCare, follow the preliminary procedures in Chapters 7.2. to 7.5.
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7.2 Ethernet connection

The Ethernet connection of Fieldgate SWG70 allows communication with a computer via the 

integral Web Server or via FieldCare. Before starting, check the following:

•  Internet Protocol TCP/IP is installed on your computer and is active

•  You have administration rights for your computer and network

•  You have an set of IP addresses that have been authorized by your IT department

•  Any proxy server for your Internet Browser is disabled

•  Firewalls allow communication on Port 502 and 5094

The procedures described in this chapter are for Windows XP. For other Windows systems consult 

your system administrator.

Fieldgate SWG70 is delivered with the default IP address:

•  192.168.1.1

In order that the host computer can communicate with the Fieldgate Web Server

•  Check that the computer can reach the Fieldgate via ports 80, 443, 502 and 5094. 

If you are not sure how to do this, consult your network administrator. 

•  For the initial commissioning, set your computer’s address to e.g. 192.168.1.200 or similar

7.2.1 Changing the IP address

Procedure for Windows XP 1 Right-click Start =>Settings =>Control Panel =>Network Connections

2 Right-click Local Area Connection => Properties

3 Using the left mouse button, double-click Internet Protocol (TCP/IP) or

click once, then click Properties. 

4 Note the original values of IP address and Subnet Mask of the computer to restore them if 

necessary at end of the operation. 
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5 Change the IP address and the Subnet Mask of the host computer to match the IP address of 

the Fieldgate. 

– IP Address 192.168.1.XXX and network mask (Subnet Mask) 255.255.255.0.

6 Click on the OK button to complete the procedure, close the other dialogs with OK and 

Close.

7.2.2 Check the connection

The simplest way to check the connection is to call up the Fieldgate SWG70 Web Server:

1 In your Internet browser enter the address of Fieldgate SWG70: 192.168.1.1 and press Enter: 

2 Accept the site certificate in the dialog which now appears.

3 Now the Login of the Web page appears. To open the Fieldgate SWG70 Web pages

– Enter User name (default: admin) and Password (default: admin) and press OK

4 If you are not able to connect to the Fieldgate:

– Ping the Fieldgate using the Command prompt

– Check that any proxy server is switched off or not used for this address range

– Check ports 80, 443, 502 and 5094 in all firewalls are open

– Check that you have the correct Ethernet cable (crossover for direct PC connection)

– Check that the Ethernet cable has been correctly connected, Chapter 5.3

– Check your IP address setting again
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7.3 RS-485 connection

Once the gateway has been connected to the RS-485 bus (see Chapter 5.4), you may connect the 

RS485 bus to your PC. This can be done by using a RS485–RS232 converter or a RS485–USB 

converter.

Procedure 1 Connect the RS-485–RS-232 converter or the RS-485–USB converter to your PC.

2 In the case of the RS-485-USB converter install any driver that is delivered with the device.

3 To find out to which COM port the converter is connected, open the Windows device manage. 

e.g. for Windows XP:

Start > Settings > Control Panel > System > Hardware > Device Manager.

4 Under "Ports (COM & LPT)" you should see the converter and the COM port assigned to it

5 Note the COM port (in this case USB Serial Port (COM5)) and the baudrate etc. as you will 

need them to set up communication



WirelessHART Fieldgate SWG70 7 Commissioning

Endress+Hauser 33

7.4 Installing FieldCare

If you do not already have FieldCare running on your computer, you can install FieldCare Device 

Setup from the corresponding DVD: will normally start automatically, otherwise via setup.exe.

7.4.1 Installing the Fieldgate DTM and HART IP CommDTM

1 Insert the Fieldgate CD ROM into the CD ROM drive: the setup program starts:

– If this is not the case, double click on Setup.exe to be found in the Fieldgate SWG70 folder

2 Click on WirelessHART Fieldgate DTM: the DTM Setup Wizard starts:

– Press Next to continue

3 The Licence Agreement dialog appears: read and accept it, then press Next to continue

– If you do not accept the licence agreement, the wizard closes

4 In the Customer Information dialog, enter details of the user, then press Next to continue

5 In the Choose Setup Type dialog, select Complete

– If the wizard has found an earlier version of the DTM, press Upgrade

6 DTM Setup Wizard now locates the FieldCare HART DTM folder and displays it in the 

Ready to Install dialog: press Install to start installation

– A progress bar indicates the state of installation

7 When installation is complete the successfully installed dialog appears:

– Press Finish to close the dialog and finish the installation

8 Repeat the procedure for the HART IP Communication DTM

9 If you intend to use the HART OPC server you can also install it in approximately the same

manner from the HART OPC Server menu item

10 Press "X" in the Setup Welcome dialog to close the setup program
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7.4.2 Update the FieldCare DTM catalog

Before they can be used, the new DTMs must be integrated in the FieldCare DTM Catalog. 

NOTE!

• For FieldCare Standard and Professional, administrator rights are required to update the 

DTM catalog

• For new FieldCare installations, follow the instructions in the FieldCare Getting Started booklet

1 Start FieldCare and log on as administrator (not necessary for FieldCare Device Setup)

2 In the Start-Up Screen dialog, press Continue and in the FieldCare dialog press Open

– An empty Project workspace appears

3 Right-click on the DTM Catalog menu and select Update...

– The Update DTM Catalog dialog appears

– Press Update to start the search for new DTMs (make take several minutes)

4 When the search is complete, the new DTM will be shown in the left-hand pane:

– Select the Wireless Fieldgate and HART IP DTMs and press Move >>

– Press OK to close the dialog and register the changes

– You are now ready to start configuration, see Chapter 8

NOTE!

• If a WirelessHART Fieldgate DTM or HART IP Communication DTM was already in the catalog, 

it is automatically updated and appears as "Changed" in the right-hand panel
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7.5 Create a FieldCare Project

Creating a FieldCare project will allow you to configure Fieldgate SWG70 and any HART device 

(field device or adapter) in the wireless network via its DTM. The configuration of a field device can 

be taken from the manufacturer’s operating manual, the configuration of the adapter is described in 

Operating Instructions BA061S/04/en, SWA70 Wireless Adapter.

7.5.1 Add the HART IP CommDTM

The HART IP CommDTM is required for communication via Ethernet with FieldCare. 

NOTE!

• If you wish to connect to FieldCare via the RS-485 interface, the HART Communication 

CommDTM must be added and configured instead of the HART IP CommDTM. 

• The procedure is similar to that described here, whereby the configuration involves other 

parameters such as selection of multiplexer option, COM port and baudrate.

1 In the FieldCare project workspace, right-click on the Host node and select Add Device...:

2 The Add New Device dialog opens:

– Select HART IP Communication and press OK

– The dialog closes and the HART IP Communication DTM is added below the Host node

3 If desired, the HART IP Communication DTM can be now configured offline

– Right-click on the node and select Configuration. 

– The node name and timeout (default 10000 ms) can be changed

– The changes are accepted when the Apply button is pressed.
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7.5.2 Add the Fieldgate SWG70

1 Right-click on the HART IP Communication node and select Add Device:

2 The Add New Device dialog opens:

– Select WirelessHART Fieldgate SWG70 and press OK

3 The dialog closes and the Fieldgate SWG70 DTM is added below the HART IP node

4 If the factory IP address (192.168.1.1) or Ethernet Port (5094) of the Fieldgate SWG70 has 

been changed, right click on the HART IP Communication node and select Additional 

Functions => Set DTM Addresses

– The Set DTM Addresses Dialog opens:

5 Enter the new IP address and/or Ethernet UDP Port number and press Update Changed 

Data

6 Close the dialog – the Fieldgate SWG70 can now be put online
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7.5.3 Parameterize Fieldgate SWG70

1 Right-click on the HART IP Communication node and select Connect

– The HART IP CommDTM is put on-line and the two arrows turn green

2 Right-click on the Fieldgate SWG70 node and select Connect:

– The Fieldgate SWG70 DTM is put on-line and the two arrows turn green

3 Right-click on the Fieldgate SWG70 node and select Online Parameterize:

– The DTM of Fieldgate SWG70 opens

4 Expand the navigation tree to reveal the parameter blocks (here shown with the 

Identification page open):

– You are now ready to configure the device, see Chapter 8
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7.5.4 Scan for wireless devices in the network

After Fieldgate SWG70 has been configured, see Chapter 8.2 onwards, you may want to scan for 

other devices in the network

1 Right-click on the Fieldgate SWG70 node and select Create Network...

– You can also click on the Create Network icon to do this

– The Fieldgate SWG70 is put on-line and the two arrows turn green

2 The Fieldgate CommDTM now scans the wireless network and automatically adds all 

WirelessHART devices found to the network (in our case the SWA70 adapters):

Note!

– If no device is found although communication has been established, check that the adapters

have been configured with the correct network identification and join key

– It may take up to ten minutes for a wireless device to join the network after download of

the Network ID and Join Key

– To increase the performance of a connection to an adapter it is possible to open a fast pipe,

see Chapter 8.2.3.
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7.5.5 Scan for devices connected to adapters

It is also possible to scan for the devices connected to the adapters. Depending on the size of the 

network and the connected field devices, however, it is possible that time out problems occur. In 

this case, FieldCare issues a warning and the user can choose to cut the connection, wait for 

connection or retry the connection.

1 Open a fast pipe to the corresponding adapter, see Chapter 8.2.3

2 Right-click on the Adapter node and select Create Network...

– You can also click on the Create Network icon to do this

– The adapter is put on-line and the two arrows turn green

3 The adapter DTM now scans the wired interface and automatically adds all HART devices 

found to the network:

– Depending upon FieldCare configuration and number of devices, this may occur

automatically or after confirmation with OK in the Scanning Result dialog. 

– Depending upon FieldCare configuration, if only one device is found, the corresponding

Device DTM will open, see below.

4 Repeat the process for all adapters in the network

5 To open the Device DTM of an unconnected transmitter right-click on the Transmitter node 

and select Connect, then right-click again and select Online Parameterization
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7.6 User interface

The Web Server and DTM of the Fieldgate SWG70 are structured in the same manner, so that the 

configuration is identical. Before starting, the Web Server must be open, see Chapter 7.2.2 or the 

Online parameterization dialog of the DTM must be open, see Chapter 7.5.3. The user interface 

is structured as follows:

The Web interface differs from the DTM only in the presentation of the parameters. In the case of 

the Web interface, the parameters are presented in a single tree. For the DTM, the Parameterization, 

Diagnostics and Additional Functions are contained in separate DTM dialogs, which must be called 

by a right-click on the Fieldgate SWG70 node and selection from the context menu. The DTM offers 

addition functions which are FDT-frame specific, e.g. Set Device Addresses. In both cases 

parameters are registered by pressing Enter. In some cases, in which more than one parameter is 

registered, an additional button must be pressed for the changes to take effect.

Parameters (DTM dialog: Online Parameterization) Chapter 8 

Identification Chapter 8.1

Wireless Communication Chapter 8.2

Setup (Basic/Advanced) Chapter 8.2.1/2

Operating modes Chapter 8.2.3

Wired Communication Chapter 8.3

Interfaces –

Serial Chapter 8.3.1

Ethernet Chapter 8.3.2

Protocols –

HART Chapter 8.3.3

Modbus Chapter 8.3.4

AMS Chapter 8.3.5

Diagnosis (DTM dialog: Diagnostics) Chapter 9

Identification Chapter 9.1

Wireless Communication Chapter 9.2

Overview Chapter 9.2.1

Details Chapter 9.2.2

Burst Lists Chapter 9.2.3

Topology View Chapter 9.2.4

Wired Communication Chapter 9.3

Overview Chapter 9.3.1

HART Chapter 9.3.2

Engineering Chapter 10

Instrument List Chapter 10.1

General Chapter 10.1.1

Creation and editing of an instrument list Chapter 10.1.2

Modbus Mapping Chapter 10.2

Modbus Settings Chapter 10.2.1

Input Status Chapter 10.2.2

Input Register Chapter 10.2.3

Topology View Chapter 10.3

Additional Functions (DTM dialog: Additional Functions => Function) Chapter 11

Reset Chapter 11.1

Self Test (DTM only) Chapter 11.2

About Chapter 11.3

Firmware Update Chapter 11.4

Change Password Chapter 11.5

Set DTM Addresses (DTM only) Chapter 11.6

Set Device Addresses (DTM only) Chapter 11.7

Upload Certificate (Web server only) Chapter 11.8

Measurement Chapter 12
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8 Fieldgate Configuration

Parameter contains all parameters related to the set-up of Fieldgate SWG70. In FieldCare the 

corresponding function is called by right-clicking on the Fieldgate SWG70 node and selecting 

Online Parameterization.

8.1 Identification

The parameters to be found in this leaf pertain to the identification of Fieldgate SWG70. The default 

parameters of Fieldgate SWG70 will appear in the appropriate input fields.

1 Click on the Parameter => Identification leaf to display the associated parameters:

– The significance of the parameters can be taken from the table below, whereby mandatory 

parameters are highlighted by bold type

2 Enter at least a Device Long Tag and Device Tag, pressing Enter to register the change.

Identification parameters Parameter Meaning Example Default

Device Long Tag Identifies Fieldgate within the plant network

– Max. 32 character ASCII "Latin 1" string

Fieldgate_

SWG70_01

–

Device Tag Identifies Fieldgate within the plant network

– Max. 8 character HART Packed ASCII string*

FG_100 –

Descriptor User text describing, e.g. function or location of Fieldgate SWG70

– Max. 16 character HART Packed ASCII string*

AREA1, 

TANKS

–

Date Date, dd.mm.yyyy, indicating the date of the last parameter change 11.07.2012 01.04.2009

Message User message, to be transmitted with information from the adapter

– Max. 32 character HART Packed ASCII string*

– –

Serial number Indicates serial number of connected Fieldgate SWG70 – –

Ext. Order Code Indicates order code of connected Fieldgate SWG70 – –

Order Code Indicate order identification of the connected Fieldgate SWG70 – –

Country Code Country in which the Fieldgate is to be used - select from list

– Governs the signal strength that can be set for the device

United 

Kingdom

Germany

* Valid character set: @ A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 

[ \ ] ^ _ blank ! " # $ % & ' ( ) * + , - . / 0 1 2 3 4 5 6 7 8 9 : ; < = > ? 
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8.2 Wireless Communication

8.2.1 Basic Setup

This leaf contains the parameters required to set up the WirelessHART communication offered by 

the Fieldgate SWG70. 

1 Click on the Parameter => Wireless Communication => Setup leaf to display the 

associated parameters:

– The significance of the parameters can be taken from the table below, whereby mandatory 

parameters are highlighted by bold type

Basic Setup parameters Parameter Meaning Example Default

Network Tag 32-character network identification tag of Fieldgate SWG70 Area_1_FG

_400

–

Network ID Unique identification number of the network

– Valid range 0 - 99999

2010 1447

Join Key Part 1 of 4 User network password, 8 hexadecimal characters, Part 1 of 4 33333333 456E6472

Join Key Part 2 of 4 User network password, 8 hexadecimal characters, Part 2 of 4 33333333 65737320

Join Key Part 3 of 4 User network password, 8 hexadecimal characters, Part 3 of 4 33333333 2B204861

Join Key Part 4 of 4 User network password, 8 hexadecimal characters, Part 4 of 4 33333333 75736572

Write Join Information Press the button to download your changes and restart the network – –

RTC Date Indicates date setting for the network – –

RTC Time Indicates time setting for the network – –

Network start date Indicates the date on which the network was created – –

Network start time Indicates the time at which the network was created – –

Allow New Devices Determines whether new devices are allowed to join the network

• All: any device can join the network

• None: no device can join the network

All All

Radio Power Determines power of the radio signal emitted by the device. 

– Selection and default value depend on the Country Code

– Observe local restrictions for 2.4 GHz equipment

10 dBm 10 dBm

Bandwidth Profile Determines Fieldgate’s bandwidth profile Normal Normal

Global Advertising

Timeout

Determines the period for global advertising on network start-up – –

Activate Global

Advertising

Press the button to activate global advertising – –
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NOTE!

• The Join Key parameters, can only be entered when DIP Switch 8 (inside the gateway housing) 

is set to ON (factory default), see Chapter 6.1.3.

Basic Setup Procedure 1 Click on Parameter => Wireless Communication => Setup 

2 Enter the following parameters, pressing Enter after each change:

– Network Tag

– Network ID

– Join Key Part 1 to Part 4

3 If your national regulations require it, set the radio power to 0dBm (most allow10 dBm)

4 Leave all other parameters at their default values, unless you want to activate global avertising 

and/or change the bandwidth profile, see below.

5 Press the Write Join Information button to download the join key

– Confirm the download with Yes

– A successful download message should now appear (clear the message with OK)

6 To activate the new network, select Reform Network in Additional Functions > Reset 

(see Chapter 11.1)

7 The wireless network is now up and running

Bandwidth Profile This option allows you to increase network performance by reducing network latency. If battery 

power is being used, this option increases energy consumption and reduces battery life. If a faster 

response time is more important than battery life, set the profile to medium or high.

To activate the new profile, always choose Reform Network in Additional Functions > Reset 

(see Chapter 11.1)

Global Advertising If Global Advertising is activated, the gateway and the network devices issue a series of identification 

messages at a rate higher than normal to identify new wireless devices and to reduce the network 

join time. The messages are sent until the Global Advertising Timeout is reached.

As Global Advertising increases energy consumption of the network devices it is recommended that 

it is activated only when needed, e.g. during the set up of the network. 

1 Enter a Global Advertising Timeout (1 ... 255 minutes)

2 Press the Activate Global Advertising button; advertising starts immediately.
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8.2.2 Advanced Setup

Channel Blacklist Where several wireless networks are in operation on a site and all are critical for plant operation, it 

is advisable to set up them up such a way that mutual interference is avoided. This is done by 

restricting the channels on which a particular network can broadcast. 

In general, a WirelessHART network dynamically adapts channel usage to new situations, for 

example if a new wireless network is installed in the area where the WirelessHART network is 

located. If WLAN and WirelessHART are used together in a production environment, it is necessary 

to set up channel usage manually in the Channel Blacklist. 

It should be noted that a WLAN channel based on the IEEE 802.11 standard is wider than a 

WirelessHART channel based on the IEEE 802.15.4 standard. If a WirelessHART network is to be 

run parallel to a IEEE 802.11 network, several WirelessHART channels must be disabled. Also note 

that the channel numbering differs for each type of network: 

For example: If the WLAN uses channel number 5, channels 5 to 8 in the WirelessHART network 

must be disabled. 

Disabling channels 1 Disable a channel by deactivating its check box in the Channel Blacklist

– The number of remaining active channels must be odd

– At least 5 channels must remain active.

2 Click Send to Device to transfer the updated blacklist settings to the Fieldgate

– Fieldgate stores the updated blacklist but does not apply the updated settings until 

the network is reformed.

3 Go to Additional Functions > Reset and click Reform Network to apply the updated 

channel blacklist.

Channel numbering

Wifi Wireless

HART

IEEE Wifi Wireless

HART

IEEE Wifi Wireless

HART

IEEE Wifi Wireless

HART

IEEE

1 1 – 4 11 –1 4 5 5 – 8 15 – 18 8 8 – 11 18 – 21 11 11 – 14 21 – 24

2 2 – 5 12 –1 5 6 6 – 9 16 – 19 9 9 – 12 19 – 22 12 12 – 15 22 – 25

3 3 – 6 13 – 16 7 7 – 10 17 – 20 10 10 – 13 20 – 23 13 13 – 15 23 – 25

4 4 – 7 14 – 17
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8.2.3 Operating Modes

Operating Modes contains a table listing all devices in the WirelessHART network together with 

their operation modes.

Whenever a wireless device joins the network, it is automatically inserted into the list, provided it 

is not already listed. Wired HART devices connected to a WirelessHART adapter are also inserted. 

The list retains all the devices Fieldgate has detected over the lifetime of the network, i.e. if a device 

is completely removed from the network, it will still be seen in the list. Such devices can be removed 

from the Operating Modes list clicking on the Delete button  which appears next to them.

1 Click on Parameter => Wireless Communication => Operating Modes to display the 

table

– The significance of the parameters can be taken from the table below

Parameter Meaning

Long Tag Identifies Fieldgate within the plant network

– For HART 5.0 or less, this is the text in the Message parameter

I/O Card Indicates the virtual I/O card number to which the device is mapped

Channel Indicates the channel of the virtual I/O card to which the device is mapped

Device Type Displays the device type as registered at the HART Communication Foundation

Status Displays the communication status

–  Connected

–  Flashing: Device connected, being identified

–  Continuous: Device connected but not identified

–  Communication failure

Dev. Status Displays the device status

–  Good

–  Out of specification

–  Failure

Note that the device status that is displayed in the list may differ from the actual device 

status because the HART status bits may be interpreted differently.

Routing Device Indicates whether the device is allowed to act a routing device.

• To deactivate the routing functionality, deactivate the corresponding check box in the 

Routing Device column. 

• This option enables you to set up a star network

Fast Pipe Establishes a direct connection to a selected device. The fast pipe connection is about 4 

times faster than a regular connection, which enables you to perform fast updates.

• Click on the check box to activate the Fast Pipe.

– Note that you can activate the Fast Pipe option for only one device at a time.

Enforce Identification Forces a device to resend its identification, for example if a communication failure 

occurred.

Flush Cache Deletes the transmitted values.

Refresh Press this button to reload the operational mode parameters of all network devices

Delete button Devices with no connection can be deleted by pressing the delete button 
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8.3 Wired Communication

8.3.1 Serial

The parameters contained in this leaf pertain to the set up of the serial interface offered by Fieldgate 

SWG70.

1 Click on the Wired Communication => Interfaces => Serial to display the associated 

parameter:

– The significance of the parameters can be taken from the table below

2 Configure the serial interface for HART or MODBUS RTU as required

3 After configuration, set up the interface protocol parameters in the appropriate "Protocol" leaf, 

see Chapters 8.3.3 and 8.3.4

– Modbus serial allows access for one master

– HART serial allows access for one primary master and one secondary master

Serial parameters Parameter Meaning Example Default

Terminal Resistor 

Selection

Specifies whether hardware (DIP switch 6) or software termination 

settings are to be used

DIP-Switch Software

Terminal Resistor Sets the termination of the wireless fieldgate when Terminal 

Resistor Selection is set to Software

– When DIP-Switch is selected, displays the setting

Connected Dis-

connected

Protocol Selection Sets the protocol to be used over the serial port HART MODBUS 

RTU
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8.3.2 Ethernet

The parameters contained in this leaf pertain to the set up of the communication to the host via 

Ethernet interface offered by Fieldgate SWG70.

1 Click on the Wired Communication => Interfaces => Ethernet to display the associated 

parameters:

– The significance of the parameters can be taken from the table overleaf, whereby mandatory 

parameters are highlighted by bold type

2 Enter the parameters, pressing Enter after each change

– Note: Automatic IP address assignment requires that there is a DHCP server in the 

Ethernet network

3 Press the Write Ethernet Information button when all parameters have been changed

– The gateway will restart with the new parameters

– If the IP address was changed, communication will be lost

– If necessary, change your computer address and re-establish communication with the 

new IP address as described in Chapter 7.2

– If you are using the HART IP CommDTM, reconfigure the communication paramters, 

see Chapter 7.5.2 Step 4, before making connection again

Ethernet parameters Parameter Meaning Example Default

IP Address 

Assignment (DHCP, 

DNS)

Specifies whether Fieldgate SWG70 IP network and DNS address is 

to be assigned manually or automatically

• Manually: The settings in the dialogue are used

• Automatically: The IP address of the DNS is assigned by a 

DHCP server

Manually Manually

IP Address Sets fixed fieldgate IP network address for manual assignment mode 192.168.1.1 192.168.1.1

Netmask Sets subnet mask IP network address for manual assignment mode 255.255.

0.0

255.255.

255.0

Gateway Address Sets default gateway TCP/IP network address

– This setting is currently not actively used by Fieldgate

– 0.0.0.0

DNS 1 Sets preferred DNS server IP address for manual assignment mode

– This setting is currently not actively used by Fieldgate

– 0.0.0.0

DNS 2 Sets alternative DNS server IP address for manual assignment mode

This setting is currently not actively used by Fieldgate

– 0.0.0.0

MAC Address Displays the MAC address of the WirelessHART gateway. 

– Note that the MAC address is a characteristic of the device itself 

and cannot be changed. Each device has its own MAC address.

– –

Write Ethernet 

Information

Downloads the changed parameters to the gateway

– If the IP address was changed, communication will be lost

– If the other addresses were changed, communication will be 

interupted for a short period

– –
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8.3.3 HART

The parameters contained in this leaf pertain to the set up of the HART communication to the host 

on the interfaces offered by Fieldgate SWG70. 

1 Click on the Wired Communication => Protocols => HART to display the associated 

parameters:

– The significance of the parameters can be taken from the table overleaf, whereby mandatory 

parameters are highlighted by bold type

2 If the default port number is changed, and FieldCare is in use, communication will be lost

– Reconfigure the HART IP CommDTM communication parameters, see Chapter 7.5.2 

Step 4, before making connection again

HART parameters Parameter Meaning Example Default

Bus Address 

Selection

Specifies whether hardware (DIP switch 0-3) or software bus 

address settings are to be used

• DIP Switch: 0 - 15

• Software: 0 - 63

Software Software

Bus Address Sets the HART address of the wireless fieldgate when Bus Address 

Selection is set to Software

– When DIP-Switch is selected, displays the setting

63 1

Baud Rate Selection Specifies whether hardware (DIP switch 4-5) or software baudrate 

settings are to be used

• DIP Switch: 9600 Bit/s - 57600 Bit/s

• Software: 1200 Bit/s - 115200 Bit/s

Software Software

Baud Rate Sets the baudrate of the wireless fieldgate when Baud Rate 

Selection is set to Software

– When DIP-Switch is selected, displays the setting

19200 19200

Port Number Sets the Fieldgate SWG70 Ethernet port number for HART via 

UDP/TCP transmission

– If the port number is changed, the default port remains open

– HART UDP allows access for two primary masters and two 

secondary masters

– HART TCP allows access for one primary masters and one 

secondary master

5094
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8.3.4 Modbus

The parameters contained in this leaf pertain to the set up of the Modbus communication to the 

host on the interfaces offered by Fieldgate SWG70. 

1 Click on the Wired Communication => Protocols => Modbus to display the associated 

parameters:

– The significance of the parameters can be taken from the table overleaf, whereby mandatory 

parameters are highlighted by bold type

Modbus parameters Parameter Meaning Example Default

Bus Address 

Selection

Specifies whether hardware (DIP switch 0-3) or software polling 

address settings are to be used

DIP-Switch Software

Bus Address Sets the HART address of the wireless fieldgate when Bus Address 

Selection is set to Software

– When DIP-Switch is selected, displays the setting

63 1

Baud Rate Selection Specifies whether hardware (DIP switch 4-5) or software baudrate 

settings are to be used

• DIP Switch Setting: 9600 Bit/s - 57600 Bit/s

• Software Setting: 1200 Bit/s - 115200 Bit/s

Software Software

Baud Rate Sets the baudrate of the wireless fieldgate when Baud Rate 

Selection is set to Software

– When DIP-Switch is selected, displays the setting

38400 38400

Parity Bit Sets the number of parity bits in the MODBUS RTU telegram

• Odd, Even or None

Odd

Stop Bit Sets the number of stop bits in the MODBUS RTU telegram

• 1, 1.5 or 2

1 1

Port Number

(Ethernet)

Sets Fieldgate SWG70 port number for MODBUS TCP transmission

– If the port number is changed, the default port remains open

– MODBUS TCP allows access for up to five masters

502
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8.3.5 AMS

If Fieldgate SWG70 is to be integrated into Emerson’s Asset Management System (AMS), this must 

be done via an Ethernet port. The port number is set in this leaf.

1 Click on the Wired Communication => Protocols => AMS to display the associated 

parameter:

– The significance of the parameters can be taken from the table, whereby mandatory 

parameters are highlighted by bold type

AMS Ethernet Port Parameter Meaning Example Default

Port Number

(Ethernet)

Sets Fieldgate SWG70 port number for AMS integration

– AMS XML allows access for one primary master and one 

secondary master

33333
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9 Diagnostics

Diagnosis contains all health and related information on Fieldgate SWG70. In FieldCare the 

corresponding function is called by right-clicking on the Fieldgate SWG70 node and selecting 

Diagnostics.

9.1 Identification

The Identification leaf contains information on the hardware and software of Fieldgate SWG70. 

The significance of the parameters is described in the table below.

1 Click on the Diagnostics => Identification to display the associated parameter:

– The significance of the parameters can be taken from the table below

Indentification parameters Parameter Meaning

Device Long Tag Identifies Fieldgate within the plant network

Device Tag Identifies Fieldgate within the plant network

Descriptor User text describing, e.g. function or location of Fieldgate

Date Indicates a date

Message User message, transmitted with information from Fieldgate SWG70

Universal Command Revision Revision of the HART protocol supported by Fieldgate SWG70

Device Revision HART Revision of device specific commands supported by Fieldgate SWG70

Software Revision HART Software revision of Fieldgate SWG70

Gateway Software Versions Indicates the firmware version installed in Fieldgate SWG70

Serial number Indicates serial number of connected Fieldgate SWG70

Order Code Indicates order code of connected Fieldgate SWG70

Order Ident Indicate order identification of the connected Fieldgate SWG70

Country Code Country Code to which Fieldgate SWG70 is set

Assembly Number The assembly number of Fieldgate SWG70
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9.2 Wireless Communication

The Wireless Communication leaf contains information on the operation of Fieldgate SWG70 

within the wireless network. 

9.2.1 Overview

Overview provides information about the I/O interfaces of the wireless network as well as network 

statistics.

1 Click on the Diagnostics => Wireless Communication => Overview leaf to display the 

associated parameters:

– The significance of the parameters can be taken from the table below.

Parameter Meaning

I/O System Capabilities

Max. Card Number Indicates the maximum number of cards in the I/O system. This corresponds to the 

maximum number of wireless devices that can be connected to the gateway.

Max. Channel Number Indicates the maximum number of channels.

Max. Sub Dev. Number Indicates the maximum number of sub devices that can be connected to a specific 

channel.

Number of Devices Indicates the current number of subdevices. Every device counts as a subdevice, no 

matter if it is a wireless device or a wired device connected to a WirelessHART adapter.

Lifetime Network Statistics

Reliability Ratio of the number of successful packet transmissions to the sum of the successful and 

permanently lost packet transmissions taken across the entire network

Stability Ratio of the number of successful packet transmissions to the sum of the successful and 

unsuccessful packet transmissions taken across the entire network

– Unsuccessful transmissions are repeated for as many time as necessary using all 

communication paths available. If the repeat process is interrupted, e.g. by removing 

the device from the network, then the corresponding packets are counted as lost.

Latency Average time taken for packets generated by the wireless devices to reach the gateway

Lost Upstream Packages Total number of packets generated by the wireless devices that were lost when 

transferred over the network.
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9.2.2 Details

NOTE!

• Diagnostic information is available only after the applicable statistics period has been completed 

(15 minutes). During this time, some information is set to 0 or replaced by wildcard characters.

Details shows all devices in the WirelessHART network together with their diagnostic information. 

Whenever a wireless device joins the network, it is automatically inserted into the list if it is not 

already there. Wired devices connected to a WirelessHART adapter are also be inserted. To remove 

a device from the list, use the Instrument List. For more information, see Chapter 10.1.

1 Click on the Diagnostics => Wireless Communication => Details leaf to display the 

associated parameters:

– The significance of the parameters can be taken from the table below.

Wireless Communication 

Details parameters

Parameter Meaning

Tree-View • Checked: Table displayed according to wireless and wired connections, see above

• Unchecked: Table displayed according to adapter and device join time

Instrument Identification Displays information identifying the device:

• Long Tag: Long Tag of connected device (= Message for devices < HART 6.0)

• IO card: Identifier of fieldgate card used by the device

• Channel: Identifier of card channel used by the device

• Device Type: Designation of connected device

• Status: Communication status of the associated device

–  Connected

–  Flashing: Device connected, being identified

–  Continuous: Device connected but not identified

–  Communication failure

• Dev. Status: Device status of the associated device

–  Good

–  Out of specification

–  Failure

The device status displayed in the Operating Modes list may differ from the actual device 

status because the HART status bits may be interpreted differently.

Number of Joins Number of times the device has joined the network

Join Time Date of the last time the device joined the network

Reliability Percentage of the packets generated by the wireless devices that were correctly received 

by the gateway

Latency Average time taken for packets generated by the wireless devices to reach the gateway

+/- Show/hide the list of neighbouring devices

Neighbors Neighbouring WirelessHART devices in reach of the selected device

RSSI Indicates the power of the signal received from the selected device by the named 

neighboring device

Stability Ratio of successful packet transmissions to the total number of packet transmissions on all 

wireless paths in the network

Refresh Updates the instrument list

Export Exports the details list to an Excel file
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9.2.3 Burst Lists

Burst mode is a special mode of a HART slave device which allows it to periodically send the 

response to a selected HART command without the being polled by the master. For a WirelessHART 

slave device, it is the main operating mode and can be used, for instance, to send the process values 

from an adapter or connected HART device to Fieldgate SWG70 at regular intervals. 

The burst lists, contain information on the devices operating in this mode. The measured values sent 

by the devices can be viewed in the Measurement List, see Chapter 12.

1 Click on the Diagnostics => Wireless Communication=> Burst Lists leaf to display the 

associated parameters:

– The significance of the parameters can be taken from the table below

Burst List parameters Parameter Meaning Example Default

Instrument 

Identification

Displays information identifying the device:

• Long Tag: Long Tag of connected device

• IO card: Identifier of fieldgate card used by the device

• Channel: Identifier of card channel used by the device

• Device Type: Designation of connected device

• Status: Communication status of the associated device

–  Connected

–  Flashing: Device connected, being identified

–  Continuous: Device connected but not identified

–  Communication failure

• Dev. Status: Device status of the associated device

–  Good

–  Out of specification

–  Failure

– –

+/- Show/hide the burst list details

Burst Command Command number of selected burst commands with explanation:

• 1: Returns the primary value and units

• 2: Returns the loop current and its associated percent of range.

• 3: Returns the loop current and up to four predefined dynamic

variables and units (PV, SV, TV, QV)

• 9: Returns the value and status of up to eight device or dynamic

variables with units

• 48:Returns the complete device status information

• 77: Embeds the commands of a connected wired device so that 

they can be transmitted by wireless

– –

Num. Packets Number of burst messages sent by the network device since the last 

network restart

– –

Refresh Updates the burst list – –
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9.2.4 Topology View (Diagnostics)

Topology view is a graphical overview of all wireless devices within your network, including their 

connection status and connection paths. It is set up in Engineering => Topology View, see 

Chapter 10.3.

1 Click on the Diagnostics => Wireless Communication => Topology View leaf to open 

the view:

– The lines between the devices represent the connection paths. 

– The color and thickness indicate the connection quality respectively traffic for each 

connection path.

– The significance of the colours, line thicknesses and other functions are to be found in the 

table which follows

2 In the example above:

– The most traffic flows between the Adapter WAD_301 and Fieldgate SWG70_01

– Less traffic flows between Adapter WAD_302 and WAD_303 respectively and 

Fieldgate SWG70_01 as well as between Adapter WAD_302 and WAD 303 respectively

and Adapter WAD_301

– There is no traffic between Adapter WAD_302 and Adapter WAD_303, but the path is

managed as a backup path in the event of one of the other paths failing. 

– The stability of all connections is good

3 Right-click on an adapter to display its network statistics
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Topology parameters Parameter Meaning

Traffic

Dotted line: Path is unused at the moment

Thin line: Path used by one third of connections

Medium lines: Path used by two thirds of connections

Thick line: Path used by all connections

Connection Quality

Signal Red: Signal stability 0 - 10% of maximum possible

Red: Signal stability 10 - 20% of maximum possible

Orange: Signal stability 20 - 30% of maximum possible

Gold: Signal stability 30 - 40% of maximum possible

Yellow: Signal stability 40 - 50% of maximum possible

Lime: Signal stability 50 - 60% of maximum possible

Light Green: Signal stability 60 - 70% of maximum possible

Lawn Green: Signal stability 70 - 80% of maximum possible

Bright Green: Signal stability 80 - 90% of maximum possible

Green: Signal stability 90 - 100% of maximum possible

Controls

Reset Zoom Resets the zoom to show everything

Refresh Updates the information on signal quality and traffic

Zoom rider – ------------ + Increases (+) or decreases (–) the magnification of the topology view

Horizontal image origin Indicates the position of the horizontal origin of the image

Vertical image origin Indicates the position of the vertical origin of the image

Resolution Indicates the resolution of the image

Paths shown Selects the paths to be shown in the topology view

– All: all paths are shown

– In use: only those paths used by the network are shown

– Selected: the paths associated with a device are shown when the cursor is moved to 

the said device

– None: No paths are shown
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9.3 Wired Communication

The Wired Communication leaf contains information on the communication interface used to 

connect to a supervisory system. It contains two sub menus: Overview and HART. 

9.3.1 Overview

Overview contains the performance parameters of the wired communication interface

1 Click on the Diagnostics => Wired Communication=> Overview leaf to open the 

overview:

– The significance of the parameters is described in the table below.

Overview parameters Parameter Meaning

Messages received through 

HOST

Total number of messages received from the host since the start-up or last reset of 

Fieldgate SWG70

Messages returned to HOST Total number of messages returned to the host since the start-up or last reset of Fieldgate 

SWG70

Number of requests forwarded 

to IO system

Total number of messages from the host forwarded to the devices in the wireless network 

since the start-up or last reset of Fieldgate SWG70

Number of responses returned 

from IO system

Total number of messages for the host received from the devices in the wireless network 

since the start-up or last reset of Fieldgate SWG70
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9.3.2 HART

The HART page shows the possible statuses that may exist for HART devices in the network. A tick 

box beside each parameter indicates whether the described condition is currently valid. 

1 Click on the Diagnostics => Wired Communication => HART leaf to open the list:

– The significance of the parameters is described in the table which follows.

– In the case of the Cumulative Extended Device Status, the user must turn to the Wireless 

Communication Details list to get more information on individual device status, 

see Chapter 9.2.2. 
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HART parameters Parameter Parameter Meaning

Extended Device Malfunction Manager fault Non-recoverable hardware fault: Fieldgate manager

Non-Volatile Memory Defect Non-recoverable hardware fault: Non-voltatile memory

Volatile Memory Defect Non-recoverable hardware fault: Voltatile memory

Ethernet communication fault Non-recoverable hardware fault: Ethernet controller

Electronic defect Non-recoverable hardware fault: Other case

RS-485 communication fault Non-recoverable hardware fault: RS-485 controller

Gateway Operation in Progress Block transfer Fieldgate transferring block

Delayed answer Fieldgate awaiting answer from device (buffer)

Self test Fieldgate is in self test mode, see Chapter 8.6.5

File update Fieldgate writing to non-volatile memory file

Start-up phase Fieldgate is starting up and building the network

Extended List changes Instrument List Changed Instrument list has changed since last refresh

Active Device List Changed Device list has changed since last refresh

Cumulative Device Status Primary Variable Out of Limits PV of a device in the network is out of limits

Non-Primary Variable Out of 

Limits

SV, TV, QV of a device in the network is out of limits

Loop Current Saturated Loop current of a a device in the network above 20 mA

Loop Current Fixed Loop current of a a device in the network is fixed to 

4 mA (multidrop mode)

More Status Available Device in the network has more status available flagged

Cold Start Device in the network has cold start flagged

Configuration Changed Configuration of a device in the network has changed

Device Malfunction Device in the network has malfunctioned

Cumulative Extended Device 

Status

Maintenance required The status "Maintenance required" has been set for a 

device in the network

Device Variable Alert The status "Device Variable Alert" has been set for a 

device in the network

Critical Power Failure The status "Critical Power Failure" has been set for a 

device in the network

Device Operation in Progress "Configuration Changed bit 

reset" procedure

Fieldgate has reset the "Configuration Changes" bit of 

one of the devices

"Sub-Device update" procedure Fieldgate is carrying out the identification of a device 

connected to an adapter

"Device update" procedure Fieldgate is carrying out the identification of an adapter
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10 Engineering

10.1 Instrument List

10.1.1 General

This leaf contains a list of instruments in the network. It is also possible to add individual devices 

that are still to be connected.

1 Click on the Engineering => Instrument List leaf to display the associated parameters:

– The significance of the parameters is described in the table below

Instrument List parameters Parameter/Field Meaning

Instrument List Displays tabular information identifying the device:

• Index: Order of the device determined according its type and the time at which it 

joined the network

• Long Tag: Long Tag of connected device (= Message <HART 5)

• IO card: Identifier of Fieldgate card used by the device

• Channel: Identifier of card channel used by the device

• Device ID: HART serial number that is assigned at manufacturing time and that differs 

for each HART device of a given type

• Extended Device Type Code: Unique code identifying the HART product family

Delete button Deletes a device from the instrument list

– Press Apply to register the change in Fieldgate SWG70

– If the device is still communicating with the network, it will automatically reappear in 

the list at the next refresh

– Caution! Deleting a device from the instrument list can change the Modbus register 

address if the Modbus addresses have been automatically generated.

Export/Export CSV Exports the current instrument list as a CSV file

Import/Import CSV Imports an instrument list that has been stored as a CSV file

Import Project Tree (DTM) In Offline Parameterize dialog, imports the network view to the Instrument List

Refresh Updates the instrument list

– After switching on or resetting the device, wait at least one minute before pressing the 

Reset button.

Apply Stores the current instrument list in Fieldgate SWG70
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10.1.2 Creation and editing of an Instrument List

Normally the Instrument List will be generated by refreshing after the network is up and running. 

It is possible, however, to create a list from scratch before any WirelessHART devices join the 

network. This allows the order in which the devices are displayed in the both the Instrument List 

and Operating Modes - and hence in the Modbus mapping - to be predetermined. The individual 

entries can also be edited.

NOTE!

• When editing the instrument list, incomplete entries are highlighted in red. These data must be 

entered or corrected before the instrument list can be downloaded to Fieldgate SWG70

• Entries marked with yellow already exist: the copies must be removed. 

Procedure for Web Server 1 Click on the Engineering => Instrument List leaf to display the instrument list

2 To add a device, click into the last row of the instrument list and enter the Long Tag of the 

device:

3 Enter the following optional additional parameters by clicking on the appropriate field:

– I/O Card to which the device should be attached

– Channel: adapters are assigned to Channel 0, devices to Channel 1 

– Device ID: unique HART serial number assigned on manufacture of the device

– Extended Device Type Code: unique code identifying the HART family type

Press Enter to confirm your entries.

NOTE!

If the values of the fields "Device ID" and "Extended Device Type Code" are unknown, "0" 

must be entered. 

4 When the instrument list is complete, press Apply to download it to Fieldgate SWG70

5 When the devices join the network at a later time, they will be assigned to their allotted 

positions in the Operating Modes list

6 When all devices have joined the network, return to the Instrument List and press Refresh 

to import the latest list

7 Press Export to store a copy of the list on your computer as a CSV file

– The file can be re-imported into the Instrument List by pressing Import and navigating 

to the folder containing the file.
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Procedure for FieldCare In addition to the previous method, in FieldCare the instrument list can also be generated by 

importing a network tree created in off-line mode. 

1 Create a FieldCare project as described in Chapters 7.5.1 and 7.5.2

– Put the HART Communication IP CommDTM and Fieldgate SWG70 CommDTM 

on line

2 Instead of scanning for devices use the Add Device context menu to add first an adapter, then 

the device or devices attached to it. 

– For WirelessHART devices without an adapter, just add the device

3 Continue until the network tree is complete

– Edit the long tags so that they correspond to those stored in your devices

4 Click on Offline Parameterize=> Engineering => Instrument List to display the empty 

instrument list

– You may have to enable the Engineering menu first

5 Press Import Project Tree to import the network tree

6 Press Export CSV to store the instrument list on your computer

7 Close the Offline Parameterize dialogue and open the Online Parameterize dialog

– Select Engineering => Instrument List to display the empty instrument list

8 Press Import CSV and import the file you have just created

9 Press Apply to download the instrument list to the Fieldgate

10 When the devices join the network at a later time, they will be assigned to their allotted 

positions in the Operating Modes list

11 When all devices have joined the network, return to the Instrument List and press Refresh 

to import the latest list

12 Press Export CSV to store a copy of the list on your computer

– The file can be re-imported into the Instrument List by pressing Import and navigating 

to the folder containing the file.



WirelessHART Fieldgate SWG70 10 Engineering

Endress+Hauser 63

10.2 Modbus Mapping

10.2.1 Modbus Settings

Modbus Settings determines how the Modbus information is to be transmitted by Fieldgate 

SWG70 and where the information is to be found. It also allows the selection of automatic or 

manual mapping. The set-up of the Modbus communication parameters (address, baudrate etc.) is 

described in Chapter 8.3.4.

More details on the Modbus Interface itself and the way in which the HART parameters are mapped 

to the Modbus registers is to be found in Appendix A. 

1 Click on the Engineering =>Modbus Mapping =>Modbus Settings leaf to display the 

associated parameters:

– The significance of the parameters is described in the table below

Modbus Settings 

parameters

Parameter Meaning Example Default

Swap Option Selects frame format swap option for Modbus data transmission

(see also Appendix A.1.3)

• Big Endian: no swap

Register 0 Register 1

Source bytes: [0xABCD] [ 0xEFGH]

Target bytes: [0xABCD] [ 0xEFGH]

• Little Endian: Register swap; 

Register 0 Register 1

Source bytes: [0xABCD] [ 0xEFGH]

Target bytes: [0xEFGH] [ 0xABCD]

The Swap Option does not apply to the Input Status registers

Big Endian Big Endian

Addressing Method Selects whether the mapping is to be done automatically or 

manually

• Auto: Mapping is done automatically according to the rules 

described in Appendix A.2

– There is no automatic mapping of Input Status

– The dialogues Input Status and Input Registers are deactivated

• Manual: Mapping is done manually or semi-automatically in the 

Input Status and/or Input Register dialogues

Manual Auto

Read Modbus Registers 

Mode

Determines in which registers the mapping is to be done

• Input Registers only: Values mapped to Input Registers 

300001...365536

• Input and Holding: Values mapped to Input Registers 

300001...365536 and Holding Registers 400001...465536

Inactive Inactive
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10.2.2 Input Status

Input Status allows the Modbus mapping of a device with single or multiple binary output. As 

Fieldgate SWG70 supports extended registers, values are normally assigned to the registers with the 

reference addresses 100001 to 165536. The reference addresses are obtained by adding the register 

number to 100,000. The dialogue checks for completeness of entries (line turns red if not correctly 

filled out) as well as double assignment to the registers (line turns yellow).

The algorithm assumes that the discrete device delivers a maximum of 256 packed discrete values, 

each of comprising 16 bits of an unsigned Integer16 (UINT16). Each bit represents a unique input 

status. Fieldgate SWG70 first splits the data into two bytes and reserves 8 registers for each byte, 

i.e. one for each bit contained.

•  Least significant byte (Bits 0 - 7) maps e.g. to registers 100001 - 100008

•  Most significant byte (Bits 8 - 15) maps e.g. to registers 100009 - 100016

The value entered after the byte selection determines which of the packed discrete values is to be 

mapped, e.g. 0 will map the first set of packed discrete values and 15 the sixteenth set of packed 

discrete values. More information is to be found in Appendix A.2.2.

NOTE!

• Some HART devices map their discrete value and status as PV in HART CMD 3. In this case the 

value and status information will be found in the appropriate Input or Holding Register, 

see Chapter 10.2.3.

• If a device status is mapped as a UINT8 to the Input Status registers, the status will be found in 

only one of the bit registers, e.g. in Bit 0. The UINT8 is stored as a 16-bit value, the MSB being 

filled with "0"s, see Chapter A.1.3.

1 Click on the Engineering =>Modbus Mapping =>Input Status leaf to display the 

associated parameters:

2 Click on Generate to open the Generate tab

– The significance of the parameters is described in the table overleaf
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Input Status parameters Parameter Meaning Example Default

Table

Register Defines the start register for the Digital I/O device values

– For Input Status the first value is normally 1

– The initial value can be overwritten only after a device has been 

selected in the Long Tag drop-down menu

– Subsequent start registers are automatically generated

1 1

End Register End register for Digital I/O device values (generated automatically) 8 65536

Long Tag Click to open a drop-down list of connected network devices – –

IO-Card Identifier of fieldgate card used by the device – –

Channel Identifier of card channel used by the device – –

Value Click to open a drop-down list of values for the selected device

– Least Significant Byte: maps bits 0 - 7 of a UINT16 to one register 

each

– Most Significant Byte: maps bits 8 - 15 of a UINT16 to one 

register each

– –

Value field Enter an appropriate value into the field which opens when a value 

is selected

– 0: the 1st discrete value of a device is mapped

...

255: the 256th discrete value of a device is mapped

0 0

Delete button Depending upon position, deletes the table or the table line – –

Generate

Start Register Defines the start register for the first Digital I/O device

– For Input Status this is normally 1

1 1

Generation Order Order in which the devices are mapped to the Modbus registers.

• Index: According to the index number, see Instrument List, 

Chapter 10.1, for example

• Alphabetical: In alphabetical order according to the Long Tag

• Alphabetical (sub-device): In alphabetical order according to the 

Long Tag of the sub-device.

• IO card & channel: According to the IO card & channel number 

of the wireless device.

• IO card & channel (sub-device): According to the IO card & 

channel number of the sub-device.

– –

Value Click to open a drop-down list of values for the selected device

– Least Significant Byte: maps bits 0 - 7 of a UINT16 to one register 

each

– Most Significant Byte: maps bits 8 - 15 of a UINT16 to one 

register each

– –

Value field Enter an appropriate value into the field which opens when a value 

is selected

– 0: the 1st discrete value of a device is mapped

...

255: the 256th discrete value of a device is mapped

0 0

Delete button Depending upon position, deletes the table or the table line – –

Generate Writes mapping table to table in Table tab – –

Delete all mappings • Checked: Overwrites any table already in Table tab

• Unchecked: Adds any new devices found to existing table

– –

Controls

Import Imports a mapping table in CSV format – –

Export Exports the current mapping table in CSV format – –

Refresh Loads the mapping table currently stored in Fieldgate SWG70 – –

Apply Stores the current mapping table to Fieldgate SWG70 – –
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Semi-automatic generation 

of Input Status mapping 

table

1 Click on the Generate tab to open the Generate dialogue:

2 Enter an offset value in the Start register field.

– For a typical application the Start value is normally 1

3 Select the order in which the devices are to be mapped to the Modbus registers in the 

Generation order drop-down list

4 Select the values you want to read for each device in the Value column

– Least Significant Byte will map Bits 0 - 7 of an UINT16

– Most Significant Byte will map Bits 8 - 15 of an UINT16

5 Enter a the index of the UINT16 to be mapped (0 to 255) into the value field which now opens

6 Repeat Steps 4 and 5 for all UINT16s

7 If required, check the Delete all Mappings checkbox to overwrite any existing mappings

– If the box is unchecked, any new devices found will be added an existing table

8 Click Generate to write the mapping to the table on the Table tab.

9 Click the Table tab to view the generated mapping table

10 Manually edit the generated mapping table by deleting unwanted entries with the delete 

button , e.g. all analog devices

– The registers occupied by the deleted entries remain free

11 After the mapping table is complete, click Apply to store it in Fieldgate SWG70.
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Manual entry of an 

Input Status mapping table

1 Click on the Table tab to open the Table dialogue:

2 Select a device from the drop-down menu that appears when the Long Tag field is clicked

3 Enter an offset value in the Register field.

– For a typical application the start value is normally 1

– Offset values > 1: only values (n +1) are allowed, where n is divisible by 8

For the first device entered, an extra field will be added for the registers 0 to e.g. 200 

that lie before the entered value

– The line turns red indicating missing entries and remains so until all entries are made

– For subsequent entries, missing values are outlined in red.

4 Select the value you want to read for the device in the Value column

– Least Significant Byte will map Bits 0 - 7 of an UINT16

– Most Significant Byte will map Bits 8 - 15 of an UINT16

5 Enter a the index of the UINT16 to be mapped (0 to 255) into the value field which now opens

6 Repeat Steps 2, 4 and 5 for all other devices

7 If required, manually edit the mapping table by deleting unwanted entries with the delete 

button 

8 After the mapping table is complete, click Apply to store it in Fieldgate SWG70.

Import and Export of 

mapping tables

The export/import functionality can be useful if you want to create the mapping table using a 

spreadsheet program, or if you want to import a backup of an existing mapping table.

1 To export the current mapping table to a CSV file, click Export. 

2 To load the mapping table from a CSV file, click Import

– Click Apply to store the imported mapping table in Fieldgate SWG70

3 To reload the mapping table currently used by Fieldgate SWG70, click Refresh



10 Engineering WirelessHART Fieldgate SWG70

68 Endress+Hauser

10.2.3 Input Register

Input Register allows the Modbus mapping of Fieldgate SWG70 and the connected HART devices. 

As Fieldgate SWG70 supports extended registers, values are normally assigned the Input Registers 

with the reference addresses 300001 to 365536 but for some Modbus systems the mapping must 

be made to the Holding Registers with the reference addresses 400001 to 465536, see Read 

Modbus Registers Mode in Chapter 10.2.1. The reference addresses are obtained by adding the 

register number to 300,000 or 400,000 respectively. The dialogue checks for completeness of 

entries (line turns red if not correctly filled out) as well as double assignment to the registers.

1 Click on the Engineering =>Modbus Mapping =>Input Register leaf to display the 

associated parameters:

2 Click on Generate to open the Generate tab

– The significance of the parameters is described in the table overleaf
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Input Register parameters Parameter Meaning Example Default

Table

Register Defines the start register for the HART device values

– For Input Register the first value is normally 30000; some 

systems work only with Holding Registers starting at 40000

– The intial value can be overwritten only after a device has been 

selected in the Long Tag drop-down menu

– Subsequent start registers are automatically generated

13 1

End Register End register for HART device values (generated automatically) 14 65531

Long Tag Click to open a drop-down list of connected network devices – –

IO-Card Identifier of fieldgate card used by the device – –

Channel Identifier of card channel used by the device – –

Value Click to open a drop-down list of values for the selected device – –

Delete button Depending upon position, deletes the table or the table line

Generate

Start Register Defines the start register for the first HART device

– For Input Registers this is normally 1, depending on the Modbus 

system in use

13 1

Generation Order Order in which the devices are mapped to the Modbus registers.

• Index: According to the index number, see Instrument List, 

Chapter 10.1, for example

• Alphabetical: In alphabetical order according to the Long Tag

• Alphabetical (sub-device): In alphabetical order according to the 

Long Tag of the sub-device.

• IO card & channel: According to the IO card & channel number 

of the wireless device.

• IO card & channel (sub-device): According to the IO card & 

channel number of the sub-device.

Value Click to open a drop-down list of values for the selected device

Delete button Depending upon position, deletes the table or the table line

Default Settings Adds all HART Command 3 values to the value list, see Appendix A

Generate Writes mapping table to table in Table tab

Delete all mappings • Checked: Overwrites any table already in Table tab

• Unchecked: Adds any new devices found to existing table

Controls

Import Imports a mapping table in CSV format

Export Exports the current mapping table in CSV format

Refresh Loads the mapping table currently stored in Fieldgate SWG70

Apply Stores the current mapping table to Fieldgate SWG70
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Semi-automatic generation 

of Input Register mapping 

table

1 Click on the Generate tab to open the Generate dialogue:

2 Enter an offset value in the Start Register field.

– For a typical application, e.g. monitoring of device values only, the Start value is normally 1

– If you intend to monitor Fieldgate SWG70 values, enter 13, in order to leave space for the

Fieldgate values

3 Select the order in which the devices are to be mapped to the Modbus registers in the 

Generation order drop-down list

4 Click Default Settings to automatically load HART CMD 3 values as well as device and status 

information into the value list

– Alternatively click in the value field and choose the values you require

– Note that the list will be replicated for all devices, so some editing may be required later

5 If required, check the Delete all Mappings checkbox to overwrite any existing mappings

– If the box is unchecked, any new devices found will be added to an existing table

6 Click Generate to write the mapping to the table on the Table tab.

7 Click the Table tab to view the generated mapping table

8 If you want to add Fieldgate SWG70 to the mapping table

– Select Fieldgate SWG70 in the Long Tag drop down menu

– Select a value from the value list

– Repeat the selection for as many Fieldgate SWG70 values as you wish to map

9 If required, manually edit the generated mapping table by deleting unwanted entries with the 

delete button 

10 After the mapping table is complete, click Apply to store it in Fieldgate SWG70.
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Manual entry of an 

Input Register mapping 

table

1 Click on the Table tab to open the Table dialogue:

2 Select a device from the drop-down menu that appears when the Long Tag field is clicked

3 Enter an offset value in the Register field.

– Offset value >1: For the first device entered, an extra field will be added for the registers

0 to e.g. 200 that lie before the entered value

– The line turns red indication mission entries and remains so until all entries are made

– For subsequent entries, missing entries are outlined in red.

4 Select the value you want to read for the device in the Value column

– If you select CMD 48 Device Status enter a response byte as well

– For more information, see CMD48 Read Additional Status Information, Chapter A.3.3

5 Repeat Steps 2, 4 and 5 for all other devices

6 If required, manually edit the mapping table by deleting unwanted entries with the delete 

button 

7 After the mapping table is complete, click Apply to store the it in Fieldgate SWG70.

Import and Export of 

mapping tables

The export/import functionality can be useful if you want to create the mapping table using a 

spreadsheet program, or if you want to import a backup of an existing mapping table.

1 To export the current mapping table to a CSV file, click Export. 

2 To load the mapping table from a CSV file, click Import

– Click Apply to store the imported mapping table in Fieldgate SWG70

3 To reload the mapping table currently used by Fieldgate SWG70, click Refresh
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10.3 Topology View (Engineering)

Topology view is a graphical overview of all wireless devices within your network, including their 

connection status and connection paths. The view set up in the dialog described here is shown in 

Diagnosis => Wireless Communication=> Topology View, see Chapter 9.2.4.

1 Click on the Engineering > Topology View leaf to open the dialogue:

– The dialog opens with icons and long tags for Fieldgate SWG70 and all WirelessHART 

devices connected to the network positioned in a blank workspace

– The significance of the parameters is described in the table below

Topology View parameters Parameter Meaning

Select Map Uploads a map in .jpg format

Reset Zoom Resets the zoom to the minimum value

Import Uploads the current devices and positions from a CSV file

Export Stores the current devices and positions in a CSV file

Refresh Updates the information on signal quality and traffic

Zoom rider – ------------ + Increases (+) or decreases (–) the magnification of the topology view

Horizontal image origin Sets the position of the horizontal origin of the image

Vertical image origin Sets the position of the vertical origin of the image

Resolution Sets the resolution of the image

Paths shown Selects the paths to be shown in the topology view

– All: all paths are shown

– In use: only those paths used by the network are shown

– Selected: the paths associated with a device are shown when the cursor is moved to 

the said device

– None: No paths are shown
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Topology View set-up The WirelessHART devices are automatically added to the topology view. If required, click Refresh 

to reload the device information. Note that reloading the device information takes some time.

1 Click Select Map to select a background image for the topology view. 

– For example, a satellite photo, a floor plan or a diagram

– The image must be in .jpg format

2 In the dialogue that now appears, click Browse to navigate to the background image.

3 Click Upload Map to upload the background image.

4 If required, edit the coordinates of the image origin in the Horizontal image origin and 

Vertical image origin boxes. 

5 Enter a value in the Resolution box to scale the background image, for example 0.4 m/pixel.
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6 Arrange the WirelessHART devices in the topology view by dragging and dropping the icons to 

a selected position. 

– For more accurate positioning use the slider to zoom in or out of the topology view. 

– To reset the zoom to show all parts, click Reset Zoom

7 When the Topology View has been set up, click Apply to store it in Fieldgate SWG70

Export and Import 1 To export the current devices and their positions to a CSV file, click Export

2 To load a list of devices and their positions from a CSV file, click Import
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11 Additional Functions

Additional Functions contains a number of functions which maybe required during the Fieldgate 

life-cycle but not for everyday operation. The functions offered depend upon the parametrization 

tool. In FieldCare the corresponding function is called by right-clicking on the Fieldgate SWG70 

node and selecting Additional Functions.

11.1 Reset

Reset allows the Fieldgate, the instrument list and the network to be reset, see table. The reset is 

intiated by pressing the appropriate button. During reset, communication with the network will be 

temporarily lost.

1 Click on the Additional Functions> Reset leaf to open the dialogue:

– The significance of the parameters is described in the table below

Reset options

11.2 Self Test

Self test invokes a self testing procedure for Fieldgate SWG70. 

1 Click on the Additional Functions> Self Test leaf to open the dialogue:

2 Press the Perform Self Test button to start the test

3 The results can be seen in the first two sections of the HART diagnosis dialogue:

Diagnostics =>Wired Communication =>HART dialog, Chapter 9.3.2

Parameter group Meaning

Device Reset Press this button to restart Fieldgate without any impact on the established network.

– Fieldgate SWG70 is restarted with all user settings intact

Rebuild Instrument List Press this button to regenerate the instrument list 

– Create a backup of the existing instrument list before resetting, see Chapter 8.6.8

– The existing instrument list is overwritten. 

– The Modbus addresses of the devices in the network may change

Reform Network Press this button to restart and reestablish the network.

– The existing instrument list is overwritten. 

– The Modbus addresses of the devices in the network may change

– Depending on the size of the network, this process may take some minutes

Reset Diagnosis Bits Press this button to reset the diagnosis bits in Fieldgate SWG70
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11.3 About

About gives information about Fieldgate SWG70. If called from FieldCare, it also gives information 

about the DTM. 

1 Click on the Additional Functions> About leaf to open the dialogue:

11.4 Firmware Upgrade (Web Server)

Firmware Upgrade allows new firmware to be downloaded to the gateway

1 Click on the Additional Functions> Firmware Upgrade leaf to open the dialogue:

2 Browse to the folder or location at which the firmware package is to be found (*.ipk, *.tar.gz)

3 Press to Upload the Package >> 

– The following page appears

4 Press the Install the Package >> button to install the firmware

– To cancel the firmware upgrade, press Discard Upgrade

5 The package will now be installed. 

– The installation process may take a while. 

– When the installation is finished, Installation Successfully Completed together with a

log is displayed on the screen.

6 After installation, Fieldgate SWG70 restarts with the new firmware

– The network configuration of the old firmware is retained
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11.5 Change Password (Web Server)

Change Password allows the password to the Web Server to be changed.

1 Click on the Additional Functions => Change password leaf to open the dialogue

2 Enter the new password in the two fields provided

3 Press the Change Password >> button to download the new password

4 The action can be cancelled immediately after entering the new password if the Discard 

Operation >> button is pressed

11.6 Set DTM Addresses (DTM)

Set DTM Addresses allows the user to match the addressing in the DTM, i.e. the Long Tag in 

WirelessHART networks, to the physical devices. Any change must also be duplicated in the Set 

Device Addresses window (see Chapter 8.6.7), otherwise the DTM is not able to establish a 

connection to the adapter. Changes should be made only after all adapter DTMs have been closed. 

The function is not relevant to FieldCare but might be required for other FDT frames.

1 Right-click on Fieldgate SWG70 node and select Additional Functions =>Set DTM 

Addresses. 

To change the DTM address:

2 Place the cursor inside a cell of the Long Tag column

3 Change the device long tag as required. You may change the long tags of several devices at 

once, if needed

4 Close any DTM dialogs of the devices whose long tags are to be changed

5 To apply the new DTM address(es) press Update Changed Tags

6 The new DTM addresses are displayed in the project view of FieldCare
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11.7 Set Device Addresses (DTM)

Set Device Addresses displays all adapters, together with their wired connections, that can be 

seen in the network. The device address is the device long tag stored in the device. 

Set Device Addresses allows the user to match the addressing of a physical device, i.e. the Long 

Tag in WirelessHART networks, to the one stored in the DTM. The function is not relevant to 

FieldCare but might be required for other FDT frames.

1 Right-click on Fieldgate SWG70 node and select Additional Functions =>Set Device 

Addresses. 

To change the device address:

2 Place the cursor inside a cell of the Device Long Tag column

3 Change the device long tag as required. You may change the long tags of several devices at 

once, if needed

4 To apply the new DTM address(es) press Update Changed Tags 

– The new DTM addresses are stored to the devices

– Refresh updates the list
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11.8 Upload Certificate (Web Server)

11.8.1 Self-signed security certificate

A digital certificate is an electronic document that binds a public key with an identity, for example, 

an organization or a user. The binding between a public key and the identity is done by a signature. 

This signature can be self-signed or authenticated by a certification authority.

Fieldgate SWG70 is delivered with a self-signed certificate for the HTTPS connection. If the web 

browser is unable to verify the authenticity of a self-signed certificate, a warning message appear:

You can proceed to the web server by clicking the appropriate option below the message.

11.8.2 Trusted security certificate

If you wish to avoid the security message, a trusted certificate must be obtained from a certification 

authority. This is usually connected with a fee and applies to one Fieldgate only. 

On registering the web server you will receive files containing a certificate and a private key. As your 

computer is probably not connected to the Internet, these should be available on its hard disk or a 

USB stick before the certificate is uploaded to Fieldgate SWG70. Now proceed as follows:

1 Click on the Additional Functions => Upload Certificate leaf to open the dialogue

2 Click Browse and select the certificate file on the hard disk or USB stick

3 Click >> to upload the certificate

4 The Upload Private Key option appears: Click Browse and select the private key on the hard 

disc or USB stick

5 Click >> to upload the private key

6 The Change Certificate and Private Key option appears: Click >> to install the trusted 

certificate.

7 Go to Additional Functions => Device Reset and perform a device reset for the changes to 

take effect. 

8 If the trusted certificate has been installed successfully, the address bar in the web browser 

displays a padlock icon, which indicates that the web interface of the WirelessHART Gateway 

is a trusted site.

NOTE!

• In some cases, you must also install the certificate locally on your operating system. 

– If so, click the warning message in the address bar of the web browser and select more 

information on the certificate.

– In the following window, click Install Certificate and follow the instructions of the 

installation wizard.
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12 Measurement

The Measurement table provides a comprehensive overview of all cached parameters and values of 

all sub-devices. 

•  As the the list is stored in a non-volatile memory, the card and channel number assignment 

will remain the same after a restart of the gateway or software

•  The dynamic values of each sub-device (analogue value, PV, SV, TV, QV) are cached by the 

gateway only if the sub-device publishes these values

•  After a network restart, the instrument list needs time to rebuild. During this time, some 

information is set to 0 or replaced by wildcard characters

•  To remove a device from the list, use the Instrument List, see Chapter 10.1

Whenever a new wireless device joins the network, it is automatically inserted into the list. Wired 

devices connected to a WirelessHART adapter are also inserted.

1 Click on the Measurement leaf to open the dialogue:

– In FieldCare right click on the Fieldgate SWG70 node and select Observe

– The significance of the parameters is described in the table below

Parameter/Field Meaning

Long Tag Identifies Fieldgate within the plant network

– For devices less than HART 6.0 the Message field is used as the long tag

IO card Identifier of Fieldgate card used by the device

Channel Identifier of card channel used by the device

Device Type Designation of connected device

Status Communication status of the associated device

–  Connected

–  Flashing: Device connected, being identified

 Continuous: Device connected but not identified

–  Communication failure

Dev. Status Device status of the associated device

–  Good

–  Out of specification

–  Failure

The device status displayed in the Operating Modes list may differ from the actual device 

status because the HART status bits may be interpreted differently.

Loop current Current in mA (for HART Multidrop = 4 mA)

PV Primary value of the device

SV Secondary variable of the device

TV Tertiary variable of the device

QV Quaternary variable of the device

"+", "–" Expands or contracts the tree view

Refresh Updates the instrument list
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13 Maintenance and Repair

13.1 Maintenance

13.1.1 General

The national requirements apply to maintenance, servicing, and inspection of associated apparatus.

No maintenance is necessary if the devices are operated properly, observing the mounting 

instructions and ambient conditions.

The devices may not be repaired, changed or manipulated. If there is a defect, the product must 

always be replaced with an original part.

13.1.2 Return to Endress+Hauser.

Fieldgate SWG70 must be returned if repairs are required or if the wrong device has been ordered 

or delivered. According to legal regulations, Endress+Hauser, as an ISO-certified company, is 

required to follow certain procedures when handling returned products, especially those that have 

been in contact with medium.

To ensure swift, safe and professional device returns, please read the return procedures and 

conditions on the Endress+Hauser website at www.services.endress.com/return-material

13.1.3 Disposal

Fieldgate SWG70 must be disposed of in accordance with national regulations.

13.1.4 Contact addresses

Contact addresses can be found on our homepage at www.endress.com/worldwide. 

For enquiries, service etc. please contact your local Endress+Hauser Sales Center or Representative.

http://www.services.endress.com/return-material
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14 Trouble-Shooting

14.1 Network optimization

Once the WirelessHART network is running, there are some simple measures that will help to 

enhance network performance and reliability. These measures are described in the following.

NOTE!

• After installation and configuration of the network, give it a couple of hours to stabilize itself, 

before taking the following steps.

14.1.1 Verify Connections

Check that each device has joined the network and is communicating properly. If you cannot 

establish a connection to a device, the device is probably too far away or an obstacle blocks the radio 

waves. In this case, add an additional device to bridge the gap.

14.1.2 Eliminate Bottlenecks

If the messages of several devices all have to pass through one single device to get to the gateway, 

the network has a bottleneck. If the device at the bottleneck fails, whole parts of the network get 

cut off from communication because there are no alternative paths to route messages.

To eliminate bottlenecks in a wireless network, add at least one device near the bottleneck to 

provide redundant communication paths. There should always be at least two communication 

devices in each signal path.

Fig. 14-1: Eliminating a bottleneck by the addition of a devices

1 Device causing bottleneck 3 Additional adapter adds alternative routes

2 Fieldgate
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14.1.3 Expand the Network

In an industrial environment, there are several potential obstacles for radio waves, for example 

buildings, walls, pipes, or even moving obstacles like trucks. Those obstacles can reflect, bend, 

diffuse or block radio waves. The effects of reflection, bending and diffusion create new waves 

which may interfere with the original ones and with each other. They can amplify or nullify each 

other. This effect is called fading.

Due to the interference of reflections, moving the antenna a few centimetres can help. If there are 

obstacles blocking transmission between wireless devices, add additional devices to provide 

alternative communication paths. The more devices exist in a WirelessHART network, the more 

reliable it becomes.

14.1.4 Optimize Coexistence with other Wireless Networks

WirelessHART networks (IEEE 802.15.4) use the frequency spectrum between 2400 ... 2483.5 

MHz. Various other wireless technologies also use this frequency spectrum, for example WLAN 

(IEEE 802.11) and Bluetooth (IEEE 802.15.1). Measures must be taken to ensure that the various 

wireless technologies do not affect each other.

If there are problems with other wireless technologies disrupting the WirelessHART network, you 

should consider implementing a Coexistence Management policy. More information on this subject 

is to be found at the HART Communication Foundation site, www.hartcomm.org, and other 

sources on the Internet.
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14.2 Diagnosis

14.2.1 Faults indicated by Fieldgate LEDS

14.2.2 Wired Communication Faults

Fieldgate error messages in plain text can be viewed in the Diagnosis leaf of the DTM, see 

Chapter 8.5.

The table below summarizes the more common problems which might occur during commissioning 

and operation of the WirelessHART Fieldgate SWG70.

LED indication Problem/Remedy

1 Red LED is lit • Hardware fault which makes normal operation of the 

gateway impossible

– Send Fieldgate back for repair

2 Red LED flashes • Under certain conditions the LED flashes while the 

gateway application tries to eliminate the fault.

– If this indication persists, even after a reboot, send the 

Fieldgate back for repair

Problem Cause/Remedy

1 The PC is not able to establish an Ethernet connection 

to the gateway, although the gateway and the PC are 

connected to the Ethernet.

• The gateway is connected to the Ethernet with a straight 

through connection although a crossover connection is 

necessary (or vice versa).

– Wire in accordance with the table in Chapter 5.3

• The Ethernet parameters of the gateway are incorrect

– Check the gateway's Ethernet parameters 

(see Chapter 8.3.2)

• The Local Area Connection Properties of your PC are not 

configured correctly

– Configure the Local Area Connection according to the 

instructions given (see chapter 7.2).

• If you are parameterizing via the web interface: Maybe 

your web browser uses proxies

– Deactivate proxies in your browser

• Firewall blocking communication

– Configure firewall to allow communication through 

ports 80, 443, 502 and 5094

2 The PC is not able to establish a serial connection to 

the gateway or the signal is of poor quality

• Wrong parameters, e.g. COM port, address range, have 

been set in the Wired Communication dialogues, (see 

Chapters 8.3.1 to 8.3.5

• The terminating resistor is not activated

– If the RS-485 cable ends at the gateway (gateway is last 

device), activate the terminating resistor via the DIP 

switch inside the gateway housing (see Chapter 6.1.3) 

or via the dialogue (see Chapter 8.3.4)

• Check cabling
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14.2.3 Wireless Communication Faults

Problem Cause/Remedy

1 Fieldgate SWG70 cannot find a WirelessHART device 

in the network

• The device has not yet joined the network

– The joining process may take a while 

– Check the join status in the gateway's Instrument List

– Alternatively, check the wireless communication 

parameters (join status) of the device via a HART 

modem connected to the device

• The device carries the wrong network ID and/or the 

wrong join key

– Check the wireless communication parameters of the 

device via a HART modem connected to the device. 

The device and the gateway must have the same 

network ID and join key.

2 The wireless connection to a WirelessHART device is 

poor and disappears from time to time

• There are not enough neighboring WirelessHART devices 

within the device's antenna range

– Check the number of neighbors 

Diagnosis > Wireless Communication

– There should beat least 2 neighbors

• Signal too weak

– Check the signal level of next neighbour in the device 

diagnosis - this must be larger than -80 dBm if the 

network is to work properly

– Improve signal strength by repositioning the antenna 

or adding adapters as repeaters

• Walls or other static/moving objects block the radio 

signals, or the antenna is not aligned vertically

– Reposition the gateway or use an external antenna.

3 The Network ID and the Join Key cannot be 

downloaded to Fieldgate SWG70

• The security DIP Switch 8 is OFF

– Set DIP Switch 8 to ON (if Gateway installed in Ex-

Zone 2, switch off power before doing this)

– If you want to continue using security mode, set the 

DIP Switch 8 to OFF, after the Network ID and Join 

Key have been downloaded

4 A device appears with a yellow icon in the instrument 

list

• Either the device or the communication is faulty

5 A device appears with a red icon in the instrument list • The device is faulty

• The network was switched off for sometime, but the 

device has continued transmitting.

– The device has gone into prolonged sleep mode

– Either wait until the device reappears (waiting time 

depends on how long the network was not present) or

press the adapter’s push button for 5 seconds to force 

joining

6 A device is present in the network, but bursting is 

interrupted

• The field device is being configured locally by a modem

– When a modem is communicating with the adapter, it 

is impossible to measure the loop current and bursting 

is disabled

– Bursting will restart when the modem is disconnected
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15 Technical Data

15.1 Input

Wireless interface WirelessHART communication interface

Physical layer IEEE 802.15.4; 2006

Transmission rate Nominal 250 kBits/s

Operating frequency 2.4 GHz (ISM band)

Transmission range Under reference conditions: Outdoor 250 m, indoor 50 m

RF power level Configurable 0 dBm or 10 dBm, depending upon natioinal regulations

Input variables Process variables according to HART standard sent in burst mode by devices in network

Additional functions • Security mode for join key and network ID download (enabled by DIP switch)

• Buffering of process values for acquisition by host application 

15.2 Output

15.2.1 Ethernet (100 BASE-T/100 BASE TX)

Protocol Configurable for HART IP and MODBUS TCP communication

Transmission rate 100 Mbit/s (max. cable length 100 m at 25 °C ambient temperature)

Type of protection None

Galvanic isolation Fully isolated from all other circuits

Maximum bus length 100 m (110 yds) depending upon cable

Connection facilities • 7-port terminal block 

• Screw terminals: 0.2 mm2 to 4 mm2 for solid wire, 0.2 mm2 to 2.5 mm2 for stranded wires

15.2.2 RS-485 serial interface

Protocol Configurable for HART Version 7.0 or MODBUS RTU communication

Transmission rate Hardware or software configurable between 1200 Bit/s to 115200 Bit/s

Type of protection None

Galvanic isolation Fully isolated from all other circuits

Maximum bus length 1200 m (1230 yds), depending upon cable and transmission rate

Terminal resistor Integrated, settable by hardware (DIP-switch) or software

Connection facilities • Two 3-port terminal blocks, allowing series connection of several Fieldgates

• Screw terminals: 0.2 mm2 to 4 mm2 for solid wire, 0.2 mm2 to 2.5 mm2 for stranded wires
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15.3 Power Supply

Supply voltage 20 VDC to 30 VDC

Power <5 W

Connection facilities • Two 2-port terminal blocks, 2nd port for redundant power supply

• Screw terminals: 0.2 mm2 to 4 mm2 for solid wire, 0.2 mm2 to 2.5 mm2 for stranded wires

15.4 Environment

Ambient temperature 

range

–20°C to +60°C, –4°F to 140°F

Storage temperature –40°C to +85°C,–40°F to +185°F 

Relative humidity 5% to 95%, non-condensing

Vibration resistance EN 60068-2-6: 1 Hz  f  150 Hz/1 g

Shock resistance EN 60068-2-27: 15 g, 11 ms

Electromagnetic 

compatibility

This device complies with the requirements of the EC Directive 2004/108/EG "Electromagnetic 

Compatibility".

• IEC 61326:

– Immunity:EN 61326-1: 2006, industrial environment

– Emission:  EN 61326-1: 2006, Class A

Telecommunication 

compliance

Complies with the requirements of the EC Telecommunications Directive 99/5/EG

• ETSI EN 300 328: V1.7.1 (2006-10) 

• ETSI EN 301 489-17: V1.2.1 (2002-08) 

• EN 301 489-17: V2.1.1 (2009)
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15.5 Mechanical Construction

Overall dimensions W x H x D: 257 mm x 85 mm x 285 mm with cable glands and antenna

257 mm x 85 mm x 115 mm without cable glands and antenna

Fig. 15-1: Dimensions of Wireless Fieldgate SWG70

Weight Approx. 1.6 kg

Housing • Material: Painted aluminium 

• Colour: Light grey, RAL 7035

Degree of protection IP 65; NEMA Type 4

Type of protection Complies with the requirements of the EC Directive 94/9/EG (ATEX)

• "nA", non-sparking to EN 60079-15:2005

Cable entry 5 separate M16x1.5 threaded entries

Antenna • Omnidirectional dipole antenna

• Intrinsically safe antenna port

• Remote antenna available on request
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15.6 Operability

Configuration • Web browser via Ethernet

• FieldCare via Ethernet (HART IP CommDTM) or RS-485 (serial CommDTM)

Operating elements • 2x Pushbuttons within housing for selecting operating mode during local configuration

• 5x LEDs within housing for indicating current operating mode during local configuration

• 1x 8-gang DIP switch for Address (1 - 4), Baudrate (5-6), Termination (7) and security mode (8)

– Hardware settings can be overridden by software settings

IP address Configurable via Web browser or DTM, default 192.168.1.1 

15.7 Certificates and Approvals

CE Mark In attaching the CE Mark, Endress+Hauser confirms that WirelessHART Fieldgate SWG70 

conforms to all relevant EU directives.

Telecommunication 

compliance

• Brazil: ANATEL 2759-11-7311 (EAN Number: 7898994191414) 

• China: CMIIT ID (SRRC)

• ETSI (R&TTE)

• FCC Part 15.247 for wireless applications in the 2.4 GHz frequency band

• Japan: Ministry of internal affairs and communication

• Mexico: COFETEL RCEPNSW12-0651

• Other national certificates are available on request.

Additional national guidelines to be observed:

Hazardous area approvals See Chapter 2.2

Country Guideline

Bulgaria General authorization required for outdoor use and public service

Italy If used outside of own premises, general authorization is required

Norway May be restricted in the geographical area within a radius of 20 km from the center 

of Ny-Alesund

Rumania Use on a secondary basis. Individual license required

Latvia The outdoor usage of the 2,4 GHz band requires an authorization from the Electronic 

Communications Office
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A Appendix: Modbus Interface

A.1 Introduction

A.1.1 Modbus protocol

Modbus is a quasi-industrial standard developed some years ago by Gould-Modicon and provides a 

messaging service that may run on a variety of physical layers. For Fieldgate SWG70 there are two 

possibilities for connecting Modbus:

•  Modbus RTU (also known as Serial) can be connected point-to-point to the RS-485C interface 

as described in Chapter 5.4.

•  Modbus TCP (also known as Modbus TCP/IP) can be connected to an Ethernet Interface as 

described in Chapter 5.3. 

The Modbus protocol exchanges data in a master-slave relationship. Each slave has a unique 

address, and the data are identified by their location in the slave address register. Certain 

characteristics of the Modbus protocol are fixed, such as the frame format, frame sequences, 

handling of communications errors, exception conditions and the functions performed. Other 

characteristics are user selectable; these include transmission medium, baudrate, character parity, 

number of stop bits, and transmission modes. Chapter 8.3 describes how both Ethernet and Serial 

interfaces can be set up. The contents of the data carried by the protocol are also freely selectable, 

i.e. nothing is said about strings, integers, floating-point numbers etc.

The Modbus protocol controls the query and response cycle between master and slave devices. Only 

the master can initiate a transaction. A query and response may involve only a single slave, or it may 

be in the form of a broadcast, in which case the slaves do not answer. The query is contained in a 

frame that includes the address of the intended receiver, what this slave is to do, data needed to 

perform the action, and a means of checking for errors. The slave checks if errors have occurred and 

performs the desired action. After the action is performed the slave builds the response and returns 

it to the master. The master can send another message to any slave as soon as it receives a valid 

response or after a user-selected time interval. This "timeout" period has to be selected on the master 

device and depends on the slave response time.

Data can be exchanged in two transmission modes: ASCII (American Standard Code for Information 

Interchange) and RTU (Remote Terminal Unit). The major differences between them are the type 

of error check performed on the message and the number of characters used. Fieldgate SWG70 

supports RTU only. Modbus offers several read, write and test functions, each identified by a code 

number. They are designed as control commands for sensors and actuators, e.g. coils, inputs, input 

registers, holding or output registers, diagnosis and test reports, programs, polling control and reset. 

For Modbus TCP the serial frame is simply inserted into the Ethernet data frame. In addition, not 

all codes are implemented.

Modbus overview Modbus RTU Modbus TCP

Standard compliance "Modbus over Serial Line" V1 "Modbus over TCP" V1

Physical layer RS-485 Ethernet

Transmission mode RTU (binary mode) TCP

Baudrates 1200 bit/s, 2400 bit/s, 4800 bit/s, 

9600 bit/s, 19200 bit/s, 38400 bit/s, 

57600 bit/s, 115200 bit/s

100 MBit/s

Partiy Odd, Even, None –

Stop bits 1; 1.5; 2 –

Polling address 1...247 –

Port No. – 502

Capabilities • Input registers starting at Modbus address 30013

• HART Command 3 dynamic variables mapped into input registers

• 2 input registers map a single HART dynamic variable

• 32bit HART floating point format used

• Status information mapped on dedicated input registers
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A.1.2 Modbus in Fieldgate

Fieldgate SWG70 is equipped with both a Modbus serial and Ethernet interface. As a result, it can 

be operated in one of the following roles: 

•  Modbus Serial Slave

•  Modbus TCP Slave

A serial or TCP slave can be accessed by one Modbus master only.

Establishing 

communication

As a TCP slave, Fieldgate SWG70 will normally communicate with the master via Port 502. If this 

port is unavailable, it is possible to specify a secondary TCP/IP port number.

Modbus commands Fieldgate SWG70 support for Modbus functions is currently as follows

Registers Modbus specifies four different types of register:

•  Discrete input registers contain the discrete input values and possibly status

•  Input registers contain analog input values and status

•  Coil registers contain discrete output values and possibly status

•  Holding registers contain analog output values and status

In addition, it is possible to "pack" discrete inputs and outputs into words, which are then stored as 

appropriate in the input or holding registers. Fig. A-1 overleaf gives an overview of the register and 

reference address ranges used for each register type. 

For Fieldgate, the holding registers are a read only image of the input registers which can be 

accessed when the Read Modbus Registers Mode is set to "Input and Holding", see Chapter 10.2.1.

HART implementation The Modbus implementation in Fieldgate SWG70 maps HART dynamic process variables over 

Modbus input registers and also uses input registers to provide device-related status information. 

The Modbus implementation is based on the following assumptions:

•  The HART Command 3 dynamic variables are used for automatic Modbus mapping

•  For Modbus access, publishing must be enabled for all relevant devices

•  The gateway caches the relevant information. Modbus commands will therefore access the 

internal gateway memory

•  Modbus input registers are only supported if they are associated with HART dynamic process 

variables

•  A device can either be a WirelessHART device or a wired HART device connected to a 

WirelessHART adapter

•  WirelessHART and wired HART devices are mapped independently within the Modbus input 

registers

Function Function Code Hex Function supported

Read discrete inputs 2 0x02 Yes

Read coils 1 0x01 No

Write single coil 5 0x05 No

Write multiple coils 15 0x0F No

Read input register 4 0x04 Yes

Read holding register 3 0x03 Yes

Write single register 6 0x06 No

Write multiple registers 16 0x10 No

Read/Write multiple register 23 0x17 No
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Fig. A-1:  Mapping of Modbus registers Fieldgate SWG70

Refresh time Fieldgate SWG70 refreshes Modbus discrete inputs and input registers once every macrocycle. The 

length of the macrocycle depends on the number of WirelessHART devices in the network, the 

response time of the devices and the number of parameters they transmit. 

In general, shorter refresh times can be attained by restricting the traffic over the network to 

essential parameters only. 
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A.1.3 Data types

Fieldgate SWG70 supports three different data types, which are interpreted and stored as described 

below: 

•  Floating point, Unsigned Integer16, Unsigned Integer8

Floating point

Unsigned16

Unsigned8

Value range (±) 1.175 * 10-38 to 3.403 * 1038 

Byte Structure

Storage Float Swapped Float

Modbus Register 1

Modbus Register 2

Sign Exponent (8 bit) Fraction (23 bit)

31 023

015 31 16

31 16 015

Value range 0 to 65.535

Byte Structure

Storage Unsigned Integer16 Swapped Unsigned Integer16

Modbus Register 1

Value (16 bit)

15 0

015 015

Value range 0 to 255

Byte Structure

Storage Unsigned Integer8 Swapped Unsigned Integer8

Modbus Register 1

Value (8 bit)

15 7 0

0 0 0 0 0 0 0 0

015 7

0 0 0 0 0 0 0 0

015 7

0 0 0 0 0 0 00
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A.2 Rules for mapping

A.2.1 Automatic mapping of analog devices (HART CMD3)

Each HART device is mapped into 12 consecutive Modbus input registers. The order of HART 

device mapping starting from register 13 is the same as the order of the sub-device identity summary 

(returned by HART CMD84). For example, the HART device with the sub-device index=1 is 

mapped starting at register 13. The device with the sub-device index = 2 is mapped starting at 

register 25, and so on.

To find out the starting register reference address of a certain sub-device, use the following formula:

SMIR = 300013 + 12*(SDI-1),

whereby: "SMIR" is the starting Modbus input register of the associated HART device

"SDI" is the sub-device index value.

The following table shows an example of the mapping of the first two HART devices, i.e. the ones 

associated with SDI=1 and SDI=2. 

The assigned Modbus registers can be viewed in the Input Status and Input Register dialogs, see 

Chapters 10.2.2 and 10.2.3

Example of Modbus 

mapping of HART CMD 3

Modbus Specific Status

HART Device Status

Reference address Modbus RTU Format Sub-device index

300013 300014 AI Primary variable (loop current, mA unit) 32-bit floating point 1

300015 300016 PV Primary variable (device-specific unit)

300017 300018 SV Secondary variable (device-specific unit)

300019 300020 TV Ternary variable (device-specific unit)

300021 300022 QV Quaternary variable (device-specific unit)

300023 – ModStat Modbus Specific Status 16-bit unsigned 

integer300024 – DevStat HART Device Status

300025 300026 AI Primary variable (loop current, mA unit) 32-bit floating point 2

300027 300028 PV Primary variable (device-specific unit)

300029 300030 SV Secondary variable (device-specific unit)

300031 300032 TV Ternary variable (device-specific unit)

300033 300034 QV Quaternary variable (device-specific unit)

300035 – ModStat Modbus Specific Status 16-bit unsigned 

integer300036 – DevStat HART Device Status

Bit Parameter Description

0x01 (LSB) Cache validity Set to 1 when the HART CMD 3 cache of the device is empty.

0x02 (LSB) Identification ongoing Set to 1 when the gateway is performing a device identification 

procedure.

0x04 (LSB) Device off-line Set to 1 when the device is off-line

Bit Parameter Description

0x01 Primary variable out of limits PV of a device in the network is out of limits

0x02 Non-primary variable out of 

limits

SV, TV, QV of a device in the network is out of limits

0x04 Loop current saturated Loop current of a device in the network above 20 mA

0x08 Loop current fixed Loop current of a device in the network is fixed to 4 mA 

(multidrop mode)

0x10 More status available Device in the network has more status available flagged

0x20 Cold start Device in the network has cold start flagged 

(power failure or device reset)

0x40 Configuration changed Configuration of a device in the network has changed

0x80 Device malfunction Device in the network has malfunctioned
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A.2.2 Digital input/output devices

There is no automatic mapping of the Input Status registers: the user must generate the mapping 

table either semi-automatically or manually. 

•  A semi-automatic mapping will duplicate the values entered under the "Generate" tab for all 

devices in the network, irrespective of device type

•  A manual mapping allows the table to be built up for each individual device (recommended)

Discrete devices publish their values by bursting HART CMD 64386. This tells Fieldgate SWG70 

how many discrete values a device is publishing as well as the index of the first discrete value. A 

maximum of 256 discrete values can be mapped for each device. At the moment, Fieldgate SWG70 

does not map the status of the device.

Each discrete value is published as a UNIT16. Fieldgate SWG70 first splits the data into two bytes 

then reserves 8 registers for each byte, i.e. one for each bit. 

•  The Least Significant Byte (x) maps Bits 0 - 7 of the value with Index x

•  The Most Significant Byte (x) maps Bits 8 - 15 of the value with Index x

The Index "x" is not determined by the position of a discrete value in the device’s burst list, but by 

its position in CMD 64385. For example, if the 1st and 4th discrete variables are selected in the 

device’s burst list, the corresponding indices will be "0" and "3". Assuming that all bytes are of 

interest, the user must enter the following lines:

•  Tag Device 1 Least Significant Byte 0

Tag Device 1 Most Significant Byte 0

Tag Device 1 Least Significant Byte 3

Tag Device 1 Most Significant Byte 3

The following (manual) mapping table results:

When Fieldgate SWG70 receives CMD 64386, it checks whether the variables have been mapped, 

then enters the associated information. Any values that are not mapped are discarded.

Reference address Device Discrete Variable Bit Byte (Variable Index)

100001 Device 1 Variable 1 Bit 0 LSB (0)

100002 Device 1 Variable 1 Bit 1 LSB (0)

...

100007 Device 1 Variable 1 Bit 6 LSB (0)

100008 Device 1 Variable 1 Bit 7 LSB (0)

100009 Device 1 Variable 1 Bit 8 MSB (0)

100010 Device 1 Variable 1 Bit 9 MSB (0)

...

100015 Device 1 Variable 1 Bit 14 MSB (0)

100016 Device 1 Variable 1 Bit 15 MSB (0)

100017 Device 1 Variable 4 Bit 0 LSB (3)

...

100025 Device 1 Variable 4 Bit 7 LSB (3)

100026 Device 1 Variable 4 Bit 8 MSB (3)

...

100032 Device 1 Variable 4 Bit 15 MSB (3)

...
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A.3 Mapping formats

A.3.1 Dynamic process variables

For each HART device, the 5 possible Command 3 floating-point dynamic variables are sequentially 

mapped (units code values are not mapped). If a device does not support a specific dynamic value, 

a "NaN" (Not a Number) floating-point value is returned (namely, 0x7F, 0xA0, 0x00, 0x00).

The CMD3 dynamic variables follow the IEEE-754 (IEC559) single-precision floating-point format

The same format is also used for the Modbus 32-bit floating point values. 

The Modbus protocol does not explicitly specify any 32-bit data element. However, the usage of 2 

consecutive 16-bit registers is the de-facto standard way to map a single-precision IEEE-754 

floating-point value. The Modbus floating value will be transmitted in the "big-endian" or "little 

endian" style according to the swap selection in the Modbus dialog, see Chapter 8.4.4. 

For example, the number 123456.00 as defined in the IEEE-754 standard appears as follows:

This number will be transmitted from the Gateway to the Modbus master in the following sequence:

47 F1 20 00

in "big-endian" style where "00" – the less significant byte – is the first one to be transmitted. The 

sequence can be changed to "little-endian", see Chapter 10.2.1.

A.3.2 Status mapping

For each HART device, two 16-bit unsigned input registers are used to map the relevant status 

information. The status information is delivered as a series of independent flags. Within an input 

register, the unused bits are always returned as "0".

•  ModStat: Modbus Specific Status

– Bit 0: Cache validity (= 1 when cache empty). If the bit is set for a long period, this

usually indicates that CMD 3 publishing is disabled for the device concerned- 13: Not used

– Bit 1: Identification ongoing (=1 when Fieldgate is identifying a device)

– Bit 3: Device off-line(= 1 when device is off-line).

•  DevStat: The "Device Status" information according to the HART 7 specification

– Bit 0: Primary variable out of limits

– Bit 1: Non-primary variable out of limits

– Bit 2: Loop current saturated

– Bit 3: Loop current fixed

– Bit 4: More status available

– Bit 5: Cold start

– Bit 6: Configuration changed

– Bit 7: Device malfunction

For more information see the Modbus Specific Status and HART Device Status tables in 

Chapter A.2.1.

1-bit Sign of Fraction 8-bit Exponent 23-bit Fraction

Byte 0 Byte 1 Byte 2 Byte 3

0x00 0x20 0xF1 0x47
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A.3.3 HART CMD48 Read Additional Status Information

Command 48 returns device status information not included in the response code or device status 

byte of Command 3. All field devices support at least bytes 0 ... 8. If a field device supports more 

than one analog channel, then bytes 9 ... 13 will be supported as well.

Response Data Bytes Byte Parameter  Description

0 Extended dev ice malfunction

(Device-specific status 0)

• 0x01 Manager fault 

• 0x02 Non-Volatile Memory Defect

• 0x04 Volatile Memory Defect 

• 0x08 Ethernet communication fault 

• 0x10 Wired Device Duplicated 

• 0x20 Long Tag Duplicated

• 0x40 Electronic defect

• 0x80 RS-485 communication fault 

1 Gateway Operation in Progress

(Device-specific status 1)

• 0x02 Block transfer (not currently supported)

• 0x04 Delayed answer 

• 0x08 Self-test (not currently supported) 

• 0x20 Device List update 

• 0x40 Network Manager Reset In Progress 

• 0x80 Start-up phase

2 Extended Lists Changes

(Device-specific status 2)

• 0x01 Instrument List Changed 

• 0x04 Active Device List changed 

3 Cumulative Device Status

(Device-specific status 3)

• 0x01 Primary Variable Out of Limits 

• 0x02 Non-Primary Variable Out of Limits 

• 0x04 Loop Current Saturated 

• 0x08 Loop Current Fixed 

• 0x10 More Status Available

• 0x20 Cold Start

• 0x40 Configuration Changed

• 0x80 Device malfunction

4 Cumulative Extended Device 

Status

(Device-specific status 4)

• 0x01 Maintenance Required

• 0x02 Device Variable Alert 

• 0x04 Critical Power Failure 

5 Device Operation in Progress

(Device-specific status 5)

• 0x02  “Configuration Changed bit reset” procedure

• 0x04  “Sub-Device update” procedure 

• 0x08  “Device update” procedure 

6 Extended device status Not relevant for Gateway, always set to "0"

7 Device operating mode For future expansions, always set to "0"

8 Standardized status 0 • 0x01 Simulation active

The device is in simulation mode and one or more of its device variables 

are not representative of the process.

• 0x02 Non-volatile memory defect

The non-volatile memory check is invalid or maybe corrupt, or the 

battery of a battery-powered memory is defective

• 0x04 Volatile memory defect

The RAM memory check is invalid or maybe corrupt.

• 0x08 Watchdog reset executed

A watchdog reset has been executed.

• 0x10 Power supply conditions out of range

The power supply is outside its allowable range.

• 0x20 Environmental conditions out of range

An internal or environmental condition is beyond acceptable limits.

• 0x40 Electronic defect

A hardware problem not related to the sensor has been detected.

9 Standardized status 1 For future expansions, always set to "0"

10 Analog channel saturated Not relevant for Gateway, always set to "0"

11 Standardized status 2 • 0x01 Sub-device list changed 

When set, the I/O system has lost communication with one of its sub-

devices or discovered a new sub-device. This bit is reset if command 74 

"Number of devices detected" is issued. The current sub-device list is 

read using command 84.

• 0x02 Duplicate master detected

The adapter has discovered another master with the same address 

connected to its token-passing interface.
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A.3.4 Read Discrete Inputs

HART Specification 285 describes the requirements for discrete and hybrid field devices. A discrete 

device will return discrete values only. A hybrid device may return both analog and discrete values. 

Discrete inputs are read by means of HART Command 64,386, which returns a block of discrete 

variables (values and status). The length of the data string depends upon the device polled. For 

further details, please consult the device manual. 

Request Data Bytes

Byte Format Description

0-1 Unsigned16 Index of First Discrete Variable to read

2 Unsigned8 Number of Discrete Variables to read (n) 

Response Data Bytes

Byte Format Description

0-1 Unsigned16 Index of first Discrete Variable Returned

2 Unsigned8 Number of Discrete Variables returned (n)

3 Bits-8 Extended Device Status

4-7 Time Time stamp for most recent change to Actual Value of first Discrete Variable Value

8-9 Unsigned16 First Discrete Variable Value

10 Bits-8 First Discrete Variable Status 

• 0x01: 1 = Discrete Variable in Simulation or Local Override

• 0x02: 1 = Discrete Variable in Fault Mode

• 0x02-0x04: Reserved, bit set to zero

11-12 Unsigned16 Second Discrete Variable Value

13 Bits-8 Second Discrete Variable Status

.....

3n+8-

3n+9

Unsigned16 Last Discrete Variable Value

3n+10 Bits-8 Last Discrete Variable Status

Command-Specific Response Codes

Code Class Description

0 Success No Command-Specific Errors

1 Undefined

2 Error Invalid Selection

3-4 Undefined

5 Error Too Few data Bytes Received

6 Error Device-Specific Command Error

7 Undefined

7 Undefined

8 Warning Set to nearest value

9-15 Undefined

16 Error Access Restricted

17-127 Undefined
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B Appendix: CSV File Formats

B.1 Structure of CSV Files

When creating or editing CSV files for import into Fieldgate SWG70, the following rules apply:

•  Use a semicolon ";" as separator for the values in the CSV file. If a value already contains a 

semicolon you must put the value into quote signs. If the value already contains quote signs, 

put the entire value into quote signs and replace the original quote signs with double quote 

signs.

Example!

The value - this is a "long tag" that contains quote signs - must be entered like this:

"this is a ""long tag"" that contains quote signs"

•  Avoid special characters. They can easily be corrupted or they can cause the whole data row 

to be skipped during the import of the CSV file.

•  Avoid leading blanks, trailing blanks, and tabs, especially for integer or hexadecimal values.

•  Respect the data type of each column.

•  If a mandatory column is missing, the whole file is rejected and nothing is imported.

•  If a mandatory value is missing, the corresponding data row is skipped.

B.2 Modbus Mapping CSV files

The files for the MODBUS mapping contain the following columns

The data in the RegisterType, InformationCode, and MappingCode columns is encoded as described 

in the tables below.

Register Type Codes

Information Code Codes

Note that the Mapping Code codes depend on the Information Code code, see Table overleaf.

Expanded 

Device Type 

Code

Device ID IO-Card Channel Long Tag Register Register 

Type

Informatio

n Code

Mapping 

Code

4 digits hex  6 digits hex integer integer string [32] integer integer integer integer

– – – – mandatory mandatory mandatory mandatory mandatory

Value Description

1 Discrete Input

3 Input Register

Value Description

0 HART Status (RegisterType Code = 3)

1 CMD 48 Status (RegisterType Code = 3)

2 Device Variables (RegisterType Code = 3)

3 MODBUS Status (RegisterType Code = 3)

4 Discrete Variables LSB (RegisterType Code = 1)

5 Discrete Variables MSB (RegisterType Code = 1)

6 Network Statistic (RegisterType Code = 3)
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Information Codes

B.3 Instrument List CSV files

The files for the instrument list contain the following columns.

B.4 Topology View CSV file

The files for the topology view contain the following columns.

Note that the X- and Y-origins of the background image are not part of the CSV file, as these 

coordinates are related to the background image.

Information Code Value Description

0 (HART Status)  0 Device Status

1 Extended Device Status

2 Device Status & Extended Device Status

1 (CMD 48 Status) 0 ... 12 CMD 48 status word to be mapped

0 maps CMD 48 bytes 0&1

1 maps CMD 48 bytes 2&3 

... and so on

12 maps CMD 48 byte 24 only

2 (Device Variable) 0 ... 242 Device Variables

For more information on what device-specific information is available and 

on the device specific unit codes, see the manual of the subdevice.

243 Battery Life

244 Percent Range

245 Loop Current

246 Primary Variable

247 Secondary Variable

248 Tertiary Variable

249 Quaternary Variable

255 Slot 0 data time stamp

3 (MODBUS Status) 0  "Mod Stat" information

4 (Discrete Variable - LSB) 0 ... 255 Discrete Variable Index

The least significant byte of the variable is mapped.

5 (Discrete Variable - MSB) 0 ... 255 Discrete Variable Index

The most significant byte of the variable is mapped.

6 (Network Statistic) 0 Reliability

1 Stability

2 Latency

3 Lost Upstream Packets

LSB: least significant byte, MSB: most significant byte

Type Code Device ID IO-Card Channel  Long Tag

4 digits hex 6 digits hex integer integer string[32]

mandatory

Expanded 

Device Type 

Code

Device ID IO-Card Channel Long Tag Units Code Range X-Coordinate Y-Coordinate Z-Coordinate

4 digits hex 6 digits hex integer integer string[32]  integer float float float float

– – – – mandatory – mandatory mandatory – –
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B.5 Details

The files you can export under Diagnostics > Wireless Communication > Details contain the 

following columns. There are no mandatory columns as there is no import function. Nevertheless, 

you can export the data in CSV format for documentation.

Expanded 

Device 

Type Code

Device 

ID

IO-Card Channel Long Tag Status Device 

Status

Number 

Of Joins

Recent 

Join Date

Reliability Latency Neighbor

s

RSSI Stability

4 digits 

hex

6 digits 

hex

integer integer string[32] 2 digits 

hex

2 digits 

hex

integer yyyy: 

mm:dd

hh:mm:ss

float float string[32] integer float
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C Appendix: HART OPC Connection

C.1 HART OPC server

The HART OPC server is software which runs under Microsoft Windows and provides a standard 

OPC communications interface with HART-capable instrumentation. 

The HART OPC server acts as a transport mechanism for communicating with HART devices. The 

interface via the server to the device is the same whether the device is connected directly to the PC 

or connected via some intermediate I/O system. While the intermediate I/O systems may vary, the 

interface to applications using the OPC server remains the same. It is possible to read out primary 

variables, send commands and parameterize a device using the HART server.

A main advantage of the HART OPC server is that access to the field devices is shared. Many OPC 

client applications (see Chapter 10.4) can access HART data from the same device or several 

different devices simultaneously. The OPC client can subscribe to the data item of interest. In 

addition, it is possible for the client, for example to only get the data item when it changes.

The HART OPC server is delivered with the product CD, see Chapter 7.4.1.

C.2 Creating an Ethernet network

1 Start the HART Server application.

Start => Programs => HART Server => HART Server

The last used project of the HART Server software will be opened automatically. 

Alternatively, if an existing project opens, create a new project by selecting 

File => New

2 Right-click on the HARTServer entry in the project window and select Add Network

3 The Add Network window opens

– Select the TCP/UDP from the drop-down menu

– Press Add to add the network to the project

NOTE!

•  Other choices are "Single port" (RS-232 to single or multidropped HART devices) or 

"Serial port RS-485" (RS-485 network to I/O system or multiplexer)

•  The configuration of the "Single port" and "Serial port RS-485" options differs slightly from that 

of the Ethernet port
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4 The Network Properties dialog opens

– Enter a network Name

– Enter the Number of Retries

– Enter the Retry Delay Base in ms

– Press OK to register the changes and add the network to your project

NOTE!

• For "RS-485" you must enter a Name, Address (COM port), Baudrate and Retries.

5 With Fieldgate SWG70 connected to the selected computer port, right click on the network 

and select Add I/O system

NOTE!

• For "RS-485" you can press Add Multiplexer... to invoke a similar procedure or Learn to 

automatically scan the network.

6 The Add Device dialog appears

– Enter the IP Address of Fieldgate SWG70 (default 192.168.1.1)

– Enter the Port (default 5094)

– Enter the Poll Address (= HART Polling Address, default 0)

– Select the UDP protocol

– Press Add to close the dialog and add the I/O system
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7 The IO System Properties dialog opens

– Press OK

8 The I/O system is added to the project

9 Now right-click on Fieldgate SWG70 node and select Learn

– The HART Server now scans the entire WirelessHART network 

– Depending on how many devices are in the network, this may take some time
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10 After scanning is complete, the network is added to Fieldgate SWG70 node:

– The result should be similar to the screenshot above

– For more details on the structure, see Chapter 3.3.1.
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C.3 Viewing and editing device properties

The HART server allows you to view and edit device properties at different levels of the network

C.3.1 Fieldgate properties

1 Right click on Fieldgate SWG70 node in the network and select properties

– The IO System Properties dialog opens

2 Gray fields are parameters loaded from Fieldgate SWG70 memory

3 White fields can be edited

– To store changes, press Flush followed by OK

– Cancel closes the dialogue and discards any changes

– The significance of the parameters can be taken from the table below

IO System Properties Parameter Meaning

IO System Identification

Tag Name A string identifying Fieldgate SWG70 - up to 32 characters.

Descriptor Additional user text decribing, e.g. function or location of adapter - up to 16 characters

Message User message, transmitted with information from Fieldgate SWG70 up to 32 characters

Manufacturer Indicates manufacturer of Fieldgate SWG70

Model Indicates device type string name

ID Indicates device identification

Revs Indicates HART Universal, Device, Software and Hardware Revisions

Operation

Master Mode Indicates whether Fieldgate SWG70 is a primary or secondary HART host 

Retries Indicates number of retries for HART communication

Statistics

Maximum Number of IO 

Cards

Maximum number of cards offered by Fieldgate SWG70

Maximum Number of IO 

Channels per IO Card

Maximum number of IO loops (channels) that can be connected to each card

Maximum Number of 

Instruments per Channel

Maximum number of instruments that fieldgate can store data for per channel

Number of Instruments 

Detected

Number of instruments currently connected to Fieldgate SWG70

Unreachable Device Number of devices which were connected to Fieldgate SWG70 but are currently not 

available
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C.3.2 Adapter properties

1 Click on the first CH001 node in the first branch then right click on the Adapter Long Tag 

that appears in the right workspace and select Properties

2 The Adapter Properties dialog opens

The significance of the parameters can be taken from the table below

IO System Properties Parameter Meaning

Adapter Identification

Tag Name A string identifying Fieldgate SWG70 - up to 32 characters.

Descriptor Additional user text decribing, e.g. function or location of adapter - up to 16 characters

Message User message, transmitted with information from Fieldgate SWG70 up to 32 characters

Manufacturer Indicates manufacturer of Fieldgate SWG70

Model Indicates device type string name

ID Indicates device identification

Revs Indicates Universal Revision, Device Revision, Software Revision, Hardware Revision

Properties

Poll Address HART bus address

Date Date on which the adapter was manufactured

Number of Preambles Number of preambles for HART communication

Operation

Master Mode Indicates whether the adapter is a primary or secondary HART host 

Retries Indicates number of retries for HART communication

Statistics

Maximum Number of IO 

Cards

Maximum number of cards offered by the adapter

Maximum Number of IO 

Channels per IO Card

Maximum number of IO loops (channels) that can be connected to each card

Maximum Number of 

Instruments per Channel

Maximum number of instruments that adapter can store data for per channel 

(in multidrop mode)

Number of Instruments 

Detected

Number of instruments currently connected to the adapter
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C.3.3 Device properties

1 Click on the second CH001 node in the first branch then right click on the Device Long Tag 

that appears in the right workspace and select Properties

– For HART Multidrop, several devices may appear

2 The Device Properties dialog opens at the Process/Output tab

This contains information on the primary value and loop current

– Gray fields are parameters loaded from the device memory

– White fields can be edited, to store changes, press Send

3 The significance of the parameters can be taken from the table below

Process/Output 

parameters

Parameter Meaning

Process

PV Indicates the current value of the primary variable

Unit select Indicates/changes the unit of the primary variable

Loop Current

Analog Value Loop-current measured by adapter (always 4 mA for HART multidrop)

Percent Range Primary value expressed as percentage of range

Upper Range Value Indicates/changes upper range value of device

Lower Range Value Indicates/changes lower range value of device

Damping Indicates/changes output damping of device

Transfer Function Indicates the type of characteristic used to convert current (mA) to engineering units



WirelessHART Fieldgate SWG70 C Appendix: HART OPC Connection

Endress+Hauser 109

4 Press the Device tab to open the Device dialog

This contains information on the tagging and range of the device

– Gray fields are parameters loaded from the device memory

– White fields can be edited, to store changes, press Send

5 The significance of the parameters can be taken from the table below

Device parameters Parameter Meaning

Device Info

Message User message, transmitted with information from the device – up to 32 characters

Tag String identifying the device - up to 8 characters if "Use Start Tag" is ticked, otherwise 32

Descriptor Additional user text describing, e.g. function or location of device – up to 16 characters

Date Indicates the date

Final Assembly Number Indicates assembly number of device

Write Protect Indicates whether write protect is in operation

Private Label Distributer Indicates label of a private distributor

Sensor Serial Number Indicates sensor serial number

Sensor Info

Upper Sensor Limit Indicates maximum value of the process variable that can be measured by the device

Lower Sensor Limit Indicates minimum value of the process variable that can be measured by the device

Minimum Span Indicates minimum span that can be set at the device

Standard Procedures

Self Test Press to initiate self-test of device

Loop Test Press to initiate test of loop to which the device is connected

Master Reset Press to reset the device and restore all factory settings

DAC Trim Trims the loop (DAC = Digital to Analog Converter)
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6 Press the HART tab to open the HART dialog

This contains information on the device hardware and software

– Gray fields are parameters loaded from the device memory

– White fields can be edited, to store changes, press Send

7 The significance of the parameters can be taken from the table below

HART parameters Parameter Meaning

HART Info

Manufacturer ID Indicates manufacturer ID of the device in plain text and as a hexadecimal number

Device Type Indicates type of the device in plain text and as a hexadecimal number

Device ID Indicates device ID as a hexadecimal number

Request preambles Indicates number of preambles for HART communication

HART Parameters

Poll Address HART bus address

Revisions

Universal Revision Indicates universal revision of the device

Device Revision Indicates device revision of the device

Software Revision Indicates software revision of the device

Hardware Revision Indicates hardware revision of the device
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8 Press the Status tab to open the Status dialog

This indicates the current status of the device

– Gray fields are parameters loaded from the device memory

– Press Read to refresh the display

9 The significance of the parameters can be taken from the table below

Status parameters Parameter Meaning

Device Status

Bit 0 to Bit 7 Standard HART status information

– A red dot indicates that the status is currently active

Command 48 Info

... Indicates information received by when Command 48 is sent to the device

– More information is available in the device manual
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10 Press the Command tab to open the Command dialog

This allows a HART command to be sent to the device and the results to be displayed

– Gray fields are parameters received from the device

– White fields can be edited, send the command, press Send

11 The significance of the parameters can be taken from the table below

Command parameters Parameter Meaning

Request

Command # (decimal) Enter the number of the command to be sent

– The device must support this command

Byte Count Indicates number of bytes sent with the command

Data (hex) Data, if any, to be sent with the command

Response

Response Code (decimal) Indicates the command sent as a response to the request

Byte Count Indicates number of bytes sent with the command

Device Staus (hex) Indicates status of the device

Data (hex) Data received as the response
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C.3.4 Device data

1 Select a channel entry (CHx) beneath the gateway in the project window, Chapter B.3.1, 

Step 10

– In the right part of the application window, you can see the device connected to 

the selected channel.

2 Right-click on the device

– Select Data from the context menu.

3 The Device Data window opens and displays all OPC data items

4 Close the window by pressing Close
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C.4 OPC client

The HART OPC Server can be used by any OPC Client Application to bring data into, e.g. a SCADA 

application. The example below uses the Data Spy client to view the data. This is supplied with 

ControlCare Application Designer and is part of ControlCare P View.

1 Open the client directly via Start => Program => ... or from the SCADA application

2 Expand the tree under HartServer.HartOpc.1 down to the instrument tags

3 Select the Instrument Tag and click the "686" icon in the manu bar

– The Select an OPC Item dialog appears

4 Expand the tree down to the Instrument Tag again
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5 Select the tag then press OK, the instrument data are displayed 

For more information on using OPC data , see the P View operating manual.
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For your notes



D Appendix: ANATEL Approval WirelessHART Fieldgate SWG70

118 Endress+Hauser

For your notes



WirelessHART Fieldgate SWG70 D Appendix: ANATEL Approval

Endress+Hauser 119

For your notes



Index WirelessHART Fieldgate SWG70

120 Endress+Hauser

Index

A
Adapter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  107

Additional Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . .  75

AMS Ethernet port  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  50

Antenna  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15

B
Burst Lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  54

Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27

C
Cable glands  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  24

Cache . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  12

Commissioning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4,  29

Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

CSV files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  99

D
Data types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  93

Degree of protection  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  24

Details  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  53

Device  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  108

Diagnosis  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  84

Diagnostics  . . . . . . . . . . . . . . . . . . . . .  51,  52,  54,  55,  58

DIP switches . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28

E
Electrical symbols  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6

EMC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5

Ethernet  . . . . . . . . . . . . . . . . . . . . . . . . . .  22,  30,  47,  102

Explosion protection  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6

F
FieldCare  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29,  33,  34

H
HART  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  58

HART CMD 3 . . . . . . . . . . . . . . . . . . . . . . . . . .  70,  94,  96

HART CMD 48 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97

HART CMD 64386 . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  98

HART communication parameters . . . . . . . . . . . . . . . . . .  48

HART IP CommDTM  . . . . . . . . . . . . . . . . . . . .  35,  36,  37

HART server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  102

Hazardous areas  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4

I
Identification . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41,  51

Input Register  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  68

Input Status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  64

Installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4

Instrument List  . . . . . . . . . . . . . . . . . . . . . .  11,  60,  61,  62

Interfaces  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  46,  47

IP address . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30

L
LEDs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  26

M
Modbus interface parameters . . . . . . . . . . . . . . . . . . . . . .  49

Modbus RTU . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  90

Modbus Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  63

Modbus TCP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  90

Mounting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19

N
Nameplate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8
Network management . . . . . . . . . . . . . . . . . . . . . . . . . . .  10

Network optimization  . . . . . . . . . . . . . . . . . . . . . . . . . . .  82

O
Online Paramaterization  . . . . . . . . . . . . . . . . . . . . . . . . .  41

OPC client . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  114

Operating elements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  25

Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  52,  57

P
Parameter  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

Power supply . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21

Protocols . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  48,  49,  50

R
Reset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  75

Reset options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  75

RS-485  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23,  32

S
Scope of delivery  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7
Security management  . . . . . . . . . . . . . . . . . . . . . . . . . . .  10

Self Test  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  75

Serial interface parameters . . . . . . . . . . . . . . . . . . . . . . . .  46

Set Device Addresses . . . . . . . . . . . . . . . . . . . . . . . . .  77,  78

Storage und transport . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7

T
Technical data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  86

Topology View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  55,  72

U
User interface  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

W
Web Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29

Website Security Certificate . . . . . . . . . . . . . . . . . . . . . . .  79

Wired Communication  . . . . . . . . . . . . . . . . . . . . . . . . . .  58

Wireless Communication . . . . . . . . . . . . . . . . . .  52,  54,  55

WirelessHART protocol  . . . . . . . . . . . . . . . . . . . . . . . . . . .  9





www.endress.com/worldwide


	BA00064S/04/EN/13.13 PV101xx WirelessHART Fieldgate SWG70
	Table of Contents
	Revision History
	Registered Trademarks

	1 Safety
	1.1 Designated use
	1.2 Installation, commissioning and operation
	1.3 Operational safety
	1.4 Conformance
	1.5 Radio Approvals
	1.6 Technical improvement
	1.7 Conventions and icons

	2 Identification
	2.1 Unpacking
	2.1.1 Visual inspection
	2.1.2 Scope of delivery
	2.1.3 Storage und transport

	2.2 Device designation
	2.3 Licensing agreement

	3 Function and System Design
	3.1 WirelessHART protocol
	3.2 WirelessHART network
	3.2.1 Network management
	3.2.2 Security management

	3.3 Connection to host applications
	3.3.1 Instrument List
	3.3.2 Cache


	4 Mechanical Installation
	4.1 Mounting considerations
	4.1.1 Positioning the Fieldgate
	4.1.2 Positioning the antenna
	4.1.3 Antenna characteristics
	4.1.4 Antenna range
	4.1.5 Examples for good and poor positioning

	4.2 Mounting the antenna
	4.2.1 Mounting the antenna supplied
	4.2.2 Requirements for a remote antenna
	4.2.3 Connecting a remote antenna

	4.3 Mounting the Fieldgate

	5 Electrical Installation
	5.1 Connections and interfaces
	5.2 Connecting to power supply and grounding
	5.3 Connecting to Ethernet
	5.4 Connecting to RS-485
	5.5 Cable glands and housing cover

	6 Operation
	6.1 Operating and display elements
	6.1.1 LEDs
	6.1.2 Buttons
	6.1.3 DIP switches


	7 Commissioning
	7.1 Preliminaries
	7.1.1 Software package
	7.1.2 Setup

	7.2 Ethernet connection
	7.2.1 Changing the IP address
	7.2.2 Check the connection

	7.3 RS-485 connection
	7.4 Installing FieldCare
	7.4.1 Installing the Fieldgate DTM and HART IP CommDTM
	7.4.2 Update the FieldCare DTM catalog

	7.5 Create a FieldCare Project
	7.5.1 Add the HART IP CommDTM
	7.5.2 Add the Fieldgate SWG70
	7.5.3 Parameterize Fieldgate SWG70
	7.5.4 Scan for wireless devices in the network
	7.5.5 Scan for devices connected to adapters

	7.6 User interface

	8 Fieldgate Configuration
	8.1 Identification
	8.2 Wireless Communication
	8.2.1 Basic Setup
	8.2.2 Advanced Setup
	8.2.3 Operating Modes

	8.3 Wired Communication
	8.3.1 Serial
	8.3.2 Ethernet
	8.3.3 HART
	8.3.4 Modbus
	8.3.5 AMS


	9 Diagnostics
	9.1 Identification
	9.2 Wireless Communication
	9.2.1 Overview
	9.2.2 Details
	9.2.3 Burst Lists
	9.2.4 Topology View (Diagnostics)

	9.3 Wired Communication
	9.3.1 Overview
	9.3.2 HART


	10 Engineering
	10.1 Instrument List
	10.1.1 General
	10.1.2 Creation and editing of an Instrument List

	10.2 Modbus Mapping
	10.2.1 Modbus Settings
	10.2.2 Input Status
	10.2.3 Input Register

	10.3 Topology View (Engineering)

	11 Additional Functions
	11.1 Reset
	11.2 Self Test
	11.3 About
	11.4 Firmware Upgrade (Web Server)
	11.5 Change Password (Web Server)
	11.6 Set DTM Addresses (DTM)
	11.7 Set Device Addresses (DTM)
	11.8 Upload Certificate (Web Server)
	11.8.1 Self-signed security certificate
	11.8.2 Trusted security certificate


	12 Measurement
	13 Maintenance and Repair
	13.1 Maintenance
	13.1.1 General
	13.1.2 Return to Endress+Hauser.
	13.1.3 Disposal
	13.1.4 Contact addresses


	14 Trouble-Shooting
	14.1 Network optimization
	14.1.1 Verify Connections
	14.1.2 Eliminate Bottlenecks
	14.1.3 Expand the Network
	14.1.4 Optimize Coexistence with other Wireless Networks

	14.2 Diagnosis
	14.2.1 Faults indicated by Fieldgate LEDS
	14.2.2 Wired Communication Faults
	14.2.3 Wireless Communication Faults


	15 Technical Data
	15.1 Input
	15.2 Output
	15.2.1 Ethernet (100 BASE-T/100 BASE TX)
	15.2.2 RS-485 serial interface

	15.3 Power Supply
	15.4 Environment
	15.5 Mechanical Construction
	15.6 Operability
	15.7 Certificates and Approvals

	A Appendix: Modbus Interface
	A.1 Introduction
	A.1.1 Modbus protocol
	A.1.2 Modbus in Fieldgate
	A.1.3 Data types

	A.2 Rules for mapping
	A.2.1 Automatic mapping of analog devices (HART CMD3)
	A.2.2 Digital input/output devices

	A.3 Mapping formats
	A.3.1 Dynamic process variables
	A.3.2 Status mapping
	A.3.3 HART CMD48 Read Additional Status Information
	A.3.4 Read Discrete Inputs


	B Appendix: CSV File Formats
	B.1 Structure of CSV Files
	B.2 Modbus Mapping CSV files
	B.3 Instrument List CSV files
	B.4 Topology View CSV file
	B.5 Details

	C Appendix: HART OPC Connection
	C.1 HART OPC server
	C.2 Creating an Ethernet network
	C.3 Viewing and editing device properties
	C.3.1 Fieldgate properties
	C.3.2 Adapter properties
	C.3.3 Device properties
	C.3.4 Device data

	C.4 OPC client

	D Appendix: ANATEL Approval
	Index


